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Important Safety Instructions 
1. Follow all warnings and instructions marked on the product.
2. Unplug this product from the wall outlet before cleaning. Do not use liquid 

cleaners or aerosol cleaners. Use a damp cloth for cleaning.
3. Do not use this product near any liquids.
4. Do not place this product on an unstable surface. The product may fall, causing 

serious damage to the product.
5. Do not drop the product.
6. Do not block the slots and openings on the back or bottom side of the chassis; to 

ensure proper ventilation and reliable operation of the product and to protect it 
from overheating, these openings must not be blocked or covered. 

7. Operate this product only from the type of power indicated on the marking label. If 
you are not sure of the type of power available, consult your dealer or local power 
company.

8. Do not allow anything to rest on the power cord. Do not locate this product where 
persons will walk on the cord.

9. If an extension cord is used with this product, make sure that the total ampere 
rating of the equipment plugged into the extension cord does not exceed the 
extension cord ampere rating. Also, make sure that the total rating of all products 
plugged into the wall outlet does not exceed the fuse rating.

10.Never push objects of any kind into this product through the chassis slots as they 
may touch dangerous voltage points or short out parts that could result in a fire or 
electric shock.

11.Unplug this product from the wall outlet and refer servicing to qualified service 
personnel under the following conditions:
a When the power cord or plug is damaged or frayed.

b If liquid has been spilled on the product.

c If the product has been exposed to rain or water.

d If the product does not operate normally when the operating instructions are followed. Adjust 
only those controls that are covered by the operating instructions since improper adjustment 
may result in damage and require extensive work by a qualified technician to restore the 
product to normal condition.

e If the product has been dropped or the chassis has been damaged.

f If the product exhibits a distinct change in performance, indicating a need for service.

12. In accordance with workstation regulation standards, do not place this device in 
the visual field of the user due to the glossy front of the case.
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WD Service and Support
Should you encounter any problem, please give us an opportunity to address it 
before returning this product. Most technical support questions can be answered 
through our knowledge base or e-mail support service at support.wdc.com. If the 
answer is not available or, if you prefer, please contact WD at the best telephone 
number shown below.

Your product includes 30 days of free telephone support during the warranty period.
This 30-day period starts on the date of your first telephone contact with WD 
technical support. E-mail support is free for the entire warranty period and our 
extensive knowledge base is available 24/7. To help us keep you informed of new 
features and services, remember to register your product online at
 https://www.wdc.com/register.

Accessing Online Support
Visit our product support website at support.wdc.com and choose from these topics:
• Downloads - Download drivers, software, and updates for your WD product.
• Registration - Register your WD product to get the latest updates and special 

offers.
• Warranty & RMA Services - Get Warranty, Product Replacement (RMA), RMA 

Status, and Data Recovery Information.
• Knowledge Base - Search by keyword, phrase, or answer ID. 
• Installation - Get online installation help for your WD product or software.

Contacting WD Technical Support 
When contacting WD for support, have your WD product serial number, system 
hardware, and system software versions available.
North America Asia Pacific

English 800.ASK.4WDC Australia 1 800 42 9861
(800.275.4932) China 800 820 6682/+65 62430496 

Spanish 800.832.4778 Hong Kong +800 6008 6008
India 1 800 11 9393 (MNTL)/1 800 200 5789 (Reliance)

011 26384700 (Pilot Line)
Europe (toll free)* 00800 ASK4 

WDEU
Indonesia +803 852 9439 

(00800 
27549338)

Japan 00 531 650442

Korea 02 703 6550
Europe +31 880062100 Malaysia +800 6008 6008/1 800 88 1908/+65 62430496 
Middle East +31 880062100 Philippines 1 800 1441 0159
Africa +31 880062100 Singapore +800 6008 6008/+800 608 6008/+65 

62430496 
Taiwan +800 6008 6008/+65 62430496 

* Toll free number available in the following countries: Austria, Belgium, Denmark, France, Germany, Ireland, 
Italy, Netherlands, Norway, Spain, Sweden, Switzerland, United Kingdom. 
MY BOOK WORLD EDITION
USER MANUAL
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Registering Your WD Product
Your WD product includes 30 days of free technical support during the applicable 
warranty period for your product. The 30-day period commences on the date of your 
first telephone contact with WD technical support. Register online at 
register.wdc.com.
WD SERVICE AND SUPPORT - 2
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Overview

Introduction
Congratulations on your purchase of My Book® World Edition™, a high-speed 
network-attached storage system with a space-saving footprint. This system is 
equipped with one or two WD drives using WD GreenPower™ technology for efficient 
cooling and power saving. The high-speed interface delivers high performance for 
small offices or home users and is ideal for backing up and sharing files over the 
Internet.

This user manual provides step-by-step installation instructions and other important 
information regarding your WD product. Translated versions and updates to this user 
manual, can be downloaded from http://products.wdc.com/updates. For more 
information and news about this product visit our website at 
www.westerndigital.com.

Drive Format
• My Book World Edition is a single-drive configuration. 

• My Book World Edition II is a dual-drive system that is pre-configured to RAID 1 
(Mirrored) mode for extra data protection. If one drive fails in RAID 1, the system 
still runs, and your data is preserved so you can replace the failed drive and 
restore the system. My Book World Edition II also supports RAID 0 (Striped) 
mode for maximum capacity and accelerated performance. For more information, 
including instructions on changing the RAID configuration for My Book World 
Edition II, see “Volumes and RAID Management” on page 124.
1
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Specifications

Ethernet High performance (10/100/1000) Gigabit Ethernet connection

Internal hard drive WD 3.5-inch SATA hard drive 

External USB storage 
file systems supported

NTFS, FAT, HFS+J

Supported protocols HTTP, HTTPS, HFS+J, CIFS/SMB, NFS, FTP

I/O ports • USB 2.0 port (for USB device expansion)
• Ethernet (RJ-45) port

Supported clients • Windows XP®

• Windows Vista™

• Windows® 7

• Windows Server® 2003
(latest service packs required)

• Mac OS® X® Tiger®

• Mac OS® X Leopard® 

• Mac OS®X Snow Leopard™

Physical dimensions My Book World Edition
• Length: 6.5 in (165 mm)
• Width: 5.4 in (137 mm)
• Height: 2.1 in (54 mm)
• Weight: 2.6 lb (1.18 kg)

My Book World Edition II
• Length: 6.5 in (165 mm)
• Width: 6.0 in (152 mm)
• Height: 3.8 in (97 mm)
• Weight: 5.5 lb (2.5 kg)

Power specifications • Input voltage: 100V to 240V AC
• Input frequency: 50 to 60 Hz
• Output voltage: 12V DC, 3A

Environmental • Operating temperature: 5 to 35 °C (41 to 95 °F)
• Non-operating temperature: -20 to 65°C (-4 to 149 °F)
OVERVIEW - 4
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Kit Contents

Accessories

Visit shopwd.com (U.S. only) to view additional accessories like cables, power 
supplies, additional hard drives, and drive mounting rails for this product. Outside the 
U.S., visit support.wdc.com.

My Book World Edition

AC adapter* Ethernet cable Installation CD with 
application software 

and user manual

Quick Install Guide

*Global AC adapter configurations

or

1 USA, Japan, Taiwan, Brazil, 
Mexico, Colombia

2 Europe, Korea, Brazil, Chile
3 United Kingdom

4 China
5 Australia, New Zealand, 

Argentina

1 2 3 4 5

1 USA, Japan, Taiwan, Brazil, 
Mexico, Colombia

2 Europe, Korea, Brazil, Chile
3 United Kingdom

4 China
5 Australia, New Zealand, 

Argentina

1 2 3 4 5
OVERVIEW - 5
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System Requirements
Note: For optimum performance, the following system and network requirements are 
recommended. Compatibility may vary depending on the user’s hardware 
configuration and operating system.

Important: For highest performance and reliability, it is recommended that 
you install the latest updates and service pack (SP). For Mac OS X, go to 
the Apple menu and select Software Update. For Windows, go to the 
Start menu and select Windows Update.

Client Computer
• Ethernet connection (network adapter)
• Operating system 

• Windows 2003 Active Directory Service/Windows XP/Windows Vista/Windows 7

• Mac OS X Tiger, Leopard, or Snow Leopard

• Web browser (Internet Explorer 6.0 SP1 and later on Windows platforms 
supported by this product; Safari 2.0 and later on Mac platforms supported by 
this product; Firefox 2.0 and later on supported Windows and Mac platforms)

• Adobe Flash ActiveX 9 or higher (required for WD Discovery™)

Local Network
• Router/switch (Gigabit required to maximize performance)

Wide Area Network
• Broadband Internet connection required for remote access using MioNet

Pre-Installation

Before unpacking and installing the system, select a suitable site for the system for 
maximum efficiency. Place the device in a site that is:

• Near a grounded power outlet
• Clean and dust free
• On a stable surface free from vibration
• Well-ventilated and away from sources of heat
• Secluded from electromagnetic fields from electrical devices such as air 

conditioners, radio, TV transmitters. 
OVERVIEW - 6
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Recording Your WD Product Information
In the following table, write the serial number and model number of your new WD 
product found on the label on the bottom of the device. Also, write the purchase date 
and other notes such as your operating system and version. This information is 
necessary for setup and technical support. 

Serial Number:

Model Number:

Purchase Date:

System and Software Notes:
OVERVIEW - 7
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System View

Ports 

Reset Button

The reset button restores configuration settings such as the network mode/IP 
address and admin name and password to default factory settings without erasing 
shared folders and volumes. For more information on how to reset the system, see 
“Resetting the My Book World Edition” on page 173.

Component Icon Description

USB port Connects to a USB hard drive for additional storage.
Note: This port makes it possible to copy files from a USB hard drive to the 
device and vice-versa using the Copy Manager feature. See “Connecting and 
Managing a USB Hard Drive” on page 163 for detailed instructions. 

Ethernet port Connects the device to a local network.

Reset button Press to restore the admin user name and password for the device.

Power port Connects the device to an AC adapter and the power outlet.

Power button

USB port
(for expansion only)

Reset button

LED

Ethernet port

Kensington® 
Security Slot
OVERVIEW - 8
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Power Button

Important: The device powers on automatically upon initial connection to 
power, which may take up to three minutes. During this time, do not press 
the power button. After the initial setup, you need to use the power button 
to turn the unit on and off. 

The power button turns the device on or off. To turn on the device, press the power 
button and hold it down until the bottom LED illuminates, and then release. Holding 
the button down for four seconds powers off the device.

When power is applied to the unit by plugging in the external power supply 
connected to the DC plug connector, the unit automatically powers up. This ensures 
the unit will automatically restart after a power failure.

If you power down a My Book World Edition by pressing the power button, and 
disconnect and then reconnect the power plug, the unit powers up for about 30 
seconds and then powers itself down. This ensures that the unit will not turn on 
accidently and remain on if there is a power failure. You need to press the power 
button to turn the unit on. 

Kensington Security Slot

For drive security, the device is equipped with a security slot, which supports a 
standard Kensington security cable. For more information on the Kensington security 
slot and available products, visit www.kensington.com.
OVERVIEW - 9
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LED Indicators (Lights)
The Power/Activity and Capacity Gauge indicators are represented by a single bar of 
six LEDs (lights) on the front panel of the drive.

Power/Activity LED Behavior

Power On Sequence

Normal Operation

Capacity Gauge
When the device is turned on, the Capacity Gauge indicates space used on the drive 
by fully illuminating six sections in an upward vertical direction. Each section 
represents approximately 17 percent of drive capacity. Because this drive is 
preformatted, the first section is illuminated upon installation.

Power Down Sequence

Device Events

Appearance Drive State

Bottom LED dimmed Powering up

LEDs light up in sequence from bottom to top Transitioning to drive ready

Appearance Drive State

Capacity Gauge, steady illumination (see below) Power-on state, ready for use

Moving up and down Drive in use

Slow flashing (every four seconds) System standby

Appearance Drive State

Dimming up/dimming down in an odd/even alternating 
pattern

Drive powering down

Appearance Drive State

Bottom LED dimmed, top LED flashing Boot unsuccessful

Fast flashing (every half second) My Book system event, action required 
(see “System Events” on page 177)

Continuous “center out” sweep pattern Unit failure
OVERVIEW - 10
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My Book World Edition Basic Setup
Step 1: Connect My Book World Edition to the Network

Follow the steps below to connect the My Book World Edition to a small 
home/office network. 

1. Connect one end of the Ethernet cable into the Ethernet port located on the back 
of the device.

2. Connect the other end of the Ethernet cable directly into a router or network 
switch port.

Note: For faster initial loading of your content, connect the cable directly to the network port of your 
computer. See page 176 for more information.

3. Connect the end of the adapter into the DC power supply socket located on the 
back of the device.

4. Plug the AC adapter into a power outlet. The unit powers up automatically.

Important: Wait for the My Book World Edition to finish powering up 
(approximately three minutes) before configuring the device. During this 
time, do not press the power button. The bottom LED on the front of the My 
Book device fully illuminates.

To power down the device, press and hold down the power button down for at 
least four seconds. 

1
2

3

4

2
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Step 2: Access My Book World Edition on the Network

You can easily find your My Book World Edition on the local area network (LAN). 
Follow the appropriate procedure below:

Windows:

• “Using WD Discovery with Windows XP/Windows Vista/Windows 7” on page 
12.

• “Using Windows Vista/Windows 7” on page 15.

Mac OS X:

• “Using Mac OS X Leopard/Snow Leopard” on page 19
• “Using Mac OS X Tiger” on page 20

Using WD Discovery with Windows XP/Windows Vista/Windows 7

Note: The WD Discovery application on the included CD should be installed on every PC connected 
to the LAN from which you intend to access your My Book World Edition.

1. Turn on your computer and wait for the operating system to load.

2. Insert the product CD into the CD or DVD ROM drive.

Note: If AutoPlay is disabled on your computer, you must install the utilities manually. Click Start and 
then (My) Computer. Right-click the CD/DVD drive, click Open, and double-click Setup.exe. 

3. Windows Vista/Windows 7: Click Run setup.exe, and then click Allow.

4. Click Accept in the Terms of Agreement screen.
MY BOOK WORLD EDITION BASIC SETUP - 12
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5. If you have connected the My Book device properly as shown in the Connect 
screen, click the Next button.

6. The Application Installer screen opens, displaying a list of options. Click 
WD Discovery Tool. Once the WD Discovery Tool installation is complete, it 
automatically launches and the WD Discovery icon displays on your desktop. 

7. Click MyBookWorld and click Map Network Drive in the Things to Do list.

A message appears asking whether you want to map the drive automatically. 

8. You have two options. Complete step (a) or step (b).
MY BOOK WORLD EDITION BASIC SETUP - 13
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(a) To map the drive automatically, click Yes.

All share folders available on the device are mapped as network drives automatically. 
Available drive letters are assigned backwards from Z. 

When mapping completes, the share folders appear as network drives in the 
WD Discovery screen. Click Back to return to the main page.

(b) To map the drive manually, click No. All share folders on the device are listed on-screen. 
Select a folder name, and then select a drive letter. Click Yes to complete drive letter 
assignment.

Note: Once a unit is mapped to a network drive, automatically or manually, it keeps the same drive 
letter.

9. Close the WD Discovery Tool.

10.Click Start and then (My) Computer. The network drives display. You can now 
drag and drop files into the network drive folders using (My) Computer or 
Windows Explorer. 
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Using Windows Vista/Windows 7

Windows Vista and Windows 7 offer an alternative to WD Discovery for easy setup 
and mapping of the unit. 

1. For Windows Vista/Windows 7, click Start>Computer>Network.

2. Right-click MyBookWorld in the Network and Sharing center and select Install 
from the drop-down menu. 

The Found New Hardware screen displays.

3. Click Locate and install driver software (recommended).
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4. Click Yes, always search online (recommended).

Windows starts searching for the driver. Depending on your system setup, it may 
take a minute or so to locate the driver.

5. When installation is complete, a confirmation message displays. Click Close. 
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A My Book World Edition icon displays next to MyBookWorld, and an Open 
option displays in the drop-down menu. 

To open the My Book World Edition shares: 

1. Right-click MyBookWorld and select Open from the drop-down menu. The 
Public, Configuration, and Download shares (default shares) display.

2. View the contents or close the screen as desired. 

To create a desktop shortcut to the My Book World Edition:

Right-click MyBookWorld and select Create Shortcut from the drop-down 
menu. 

To view the My Book World Edition web page: 

Right-click MyBookWorld and select View device webpage from the drop-
down menu. The login page appears. 
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Note: (See “Accessing My Book World Edition’s Network Storage Manager” on page 86 for 
information on logging in.)

To view the properties of the My Book World Edition: 

1. Right-click MyBookWorld and select Properties from the drop-down menu. 

The MyBookWorld Properties screen displays. 

2. Click OK to close the screen.
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Using Mac OS X Leopard/Snow Leopard

1. Turn on your computer and wait for the operating system to load.

2. Open Finder.

3. In Finder, click MyBookWorld in the Shared list (if necessary, click All and then 
double-click MyBookWorld). 

Note: Configuration is a read-only share containing only a Help file and the login page.

4. Double-click the Public share. 

The share may appear as a shared drive icon on the desktop depending on your 
preferences. You can now drag and drop files into the network drive folders using 
Finder. 

5. If you want to make the shared drive icon permanent on the desktop, create an 
alias. Following are two ways to do that:

Note: Before creating an alias, click Finder>Preferences and make sure Connected Servers is 
checked.

• Click the item you wish to alias and hold down the mouse button. Hold down 
the Cmd and Option keys simultaneously and drag the item to where you 
want the alias to appear. Instead of moving the original item, this creates an 
alias at the new location. 
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• Double-click the item you want to alias (e.g., the Public share icon), and then 
click File>Make Alias. 

The Public share icon displays on your desktop.

Using Mac OS X Tiger

1. Turn on your computer and wait for the operating system to load.

2. Open Finder, and double-click the Mybookworld icon. 

3. Type “admin” in both the Name and Password fields, and then click Connect.

4. Make sure that Public is highlighted in the Select the volumes to mount list, 
and then click OK. 
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5. Double-click the Public icon that is now on your desktop to display three shared 
subfolders. You can now drag and drop files into the shared folders using Finder. 

6. If you want to make the shared drive icon permanent on the desktop, create an 
alias. Following are two ways to create to do that:

Note: Before creating an alias, click Finder>Preferences and make sure Connected Servers is 
checked.

• Click the item you wish to alias and hold down the mouse button. Hold down 
the Cmd and Option keys simultaneously and drag the item to where you 
want the alias to appear. Instead of moving the original item, this creates an 
alias at the new location. 

• Double-click the item you want to alias (e.g., the Public share icon), and then 
click File>Make Alias. 

The Public share icon displays on your desktop.
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Congratulations!

Your My Book World Edition is now ready for use and is accessible as a drive letter in 
My Computer (Windows) or a shared drive icon on the desktop (Mac OS X). You can 
now drag and drop files into your My Book device and move files from My Book to 
any computer in your network that has been set up according to the instructions 
above.

This user manual contains information and instructions for all other basic and 
advanced My Book device management functions, including:

• Backing up your computer (see “Backing Up Computers on the Network” on 
page 23)

• Accessing My Book from a remote computer (see “MioNet® Remote Access” on 
page 54)

• Playing and streaming media (see “How to Play/Stream Video, Music & Photos” 
on page 64)

• Using iTunes®service (see “Using iTunes with My Book World Edition” on page 
73)

• Connecting a USB drive for additional storage and file exchange (see “Using WD 
Discovery (Windows only)” on page 75 and “Click the Submit button to apply the 
changes.” on page 162)

• Configuring the My Book device and network settings, set e-mail or window 
alerts, change the administrator password, perform firmware upgrades, restore 
system to factory defaults, configure RAID (My Book World Edition II only), 
manage file share preferences, set the backup destination folder, set disk quotas, 
set a share folder for users, add, modify, and delete users and groups, and 
change all user and group permissions (read/write, read only, no access) to 
shares/folders and USB storage devices (see “Network Storage Manager: 
Basics” on page 81)
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Backing Up Computers on the Network

WD Anywhere Backup Overview

WD Anywhere Backup software is a quick, easy and secure way to back up all the 
computers in your network. Your My World Book Edition CD comes with five licenses 
for WD Anywhere Backup—each one enabling you to activate a single PC or Mac for 
continuous backup. Select the files you want to back up, and then set the My Book 
World Edition and forget it; every time you make a change in your files, it’s 
automatically backed up.

Important Installation Notes
• Install on Each Computer: You must use the Installation CD to install WD 

Anywhere Backup on each computer in your network.

• Connect to the LAN and Power On First: You must have your My World Book 
Edition connected to your local area network and powered on before you install 
WD Anywhere Backup software. This ensures that the WD Anywhere Backup 
recognizes your My World Book Edition and installs as the full software version 
instead of the 30 Day trial version.

• Laptop Users: When you are travelling, your laptop files are not being backed 
up. Your files be backed up automatically upon reconnection with your home 
network.

Windows

1. Turn on your computer and wait for the operating system to load.

2. Insert the software CD into the CD-ROM drive.

Note: If AutoPlay is disabled on your computer, you must install the utilities manually. Click Start and 
then Computer (Windows Vista/Windows 7) or My Computer (Windows XP). Right-click the 
CD/DVD drive, click Open, and double-click Setup.exe.

3. Windows Vista/Windows 7: Click Run setup.exe and then click Allow.

4. Click Accept in the Terms of Agreement screen.

5. If you have connected the device properly as shown in the Connect screen, click 
the Next button.

6. Click WD Anywhere Backup. 

Note: It may take a minute or two for the next screen to display.
3
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7. Select your preferred language from the list and click OK.

8. Close all other open applications, and then click the Next button to continue.

9. If you accept the terms of the agreement, click I Agree to continue.

10.After WD Anywhere Backup has finished installing, click Finish to begin using 
WD Anywhere Backup. 
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The WD Anywhere Backup Configuration screen displays. Continue with 
“Configuring WD Anywhere Backup” on page 26. 

Note: The WD Anywhere Backup icon now displays on your desktop, and WD Anywhere 
Backup is listed in Program Files. 

Mac OS X

1. Turn on your computer and wait for the operating system to load.

2. Insert the software CD into the CD-ROM drive.

3. Double-click the My Book World Edition CD icon that mounts to the desktop.

4. Open the WD_Mac_Tools folder and double-click WDAnywhereBackup.dmg.

5. Continue with “Configuring WD Anywhere Backup” on page 26.
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Configuring WD Anywhere Backup

After starting WD Anywhere Backup as described in the previous chapter, you can 
back up your data using several methods. 

One-Click Backup

WD Anywhere Backup allows you to back up all your important data, such as 
documents, photos, music and videos, on your computer’s hard drive with the click of 
a button. This feature backs up your data to the My Book World Edition so you can 
restore your data in the event that your computer’s hard drive crashes.

The first time you install WD Anywhere Backup, the WD Anywhere Backup 
Configuration screen appears.

Note: The screen below only appears when you have My Book World Edition attached to your 
computer’s local area network.

This screen offers two options:

Automatic Backup (Begin Backup Button)

The main option is to have the My Book World Edition automatically and continuously 
back up your files, providing assurance that your files can always be restored.

• What it backs up: One-click backup backs up documents, photos, and media 
files on the primary drive of your computer. 

• What it does not back up: One-click backup does not include files on the A: 
drive, application files such as MS Word or Adobe Acrobat, temporary and log 
files, virtual hard disk files, or files in the system folders. 
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Customized Backup: The other option is to customize your backup to back up only 
selected types of files, for example, only photos or videos, or other drives. 

To start an automatic and complete backup of your computer’s hard drive:

1. Click the Begin Backup button.

2. A message explains that initial backup will use moderate resources on your 
computer. To pause the backup, click Pause until System Idle. To keep the 
backup running in the background, click Continue. 

Note: If you do not want these messages to display in the future, click Do not show Configuration 
Wizard at startup.

3. A registration screen appears. If desired, enter the optional registration 
information. Click Continue.
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The WD Anywhere Backup screen displays the progress of the backup and the 
percentage of CPU used.

When the backup has finished, a backup complete message displays.
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To customize a backup plan:

1. Click the Customize My Backup link at the bottom right of the WD Anywhere 
Backup Configuration screen. The Welcome to the WD Anywhere Backup 
Wizard screen appears. 

2. Continue with step 3 in How to Create a Backup Plan.

How to Create a Backup Plan

Creating and customizing a backup plan allows you to automatically safeguard 
against data loss.

1. If WD Anywhere Backup is not already running, click the WD Anywhere Backup 
icon on the desktop. 

2. Click Create. (If the screen shows no backup plans, none have been created.) 
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3. The welcome screen displays. Click the Next button.

4. Click Network Places to locate your My Book World Edition on your local area 
network. Click the Next button.
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5. Click All Items from SmartPicks.

You have two options:

• To select specific items: See “Selecting your own backup items” on page 34.
• To select all items: continue with the procedure below.

Selecting all items from SmartPicks

1. Click the All Items from SmartPicks button. The File Tally screen may appear:

2. If you do not want to see this message again, select the check box at the bottom. 
Click OK. 
BACKING UP COMPUTERS ON THE NETWORK - 31



MY BOOK WORLD EDITION
USER MANUAL
3. The SmartPicks screen displays, listing common file types that you can back up.

Select each file type you want to back up. You can also click Select None to 
clear all selections, or click Select All to select all of the items. 

4. To add more items, click the Add Backup Items button. The Local Folders tab 
displays. Select additional folders and click Select.
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5. To exclude more items from your plan:
(a) Click the Show Advanced Items button.

(b) Click the Add Exclusion button.

(c) Select items to exclude from the backup plan, or click the Select Folder to Exclude and 
select any folders from the plan. Click the Select button.

6. On the Items Selected for Backup screen, click the Next button. 

7. Continue with “Completing the Backup Plan” on page 35.
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Selecting your own backup items

1. Click the My Own Backup Items button. The SmartPicks screen appears, 
listing default file locations you can back up. 

2. You have two options:
(a) On the SmartPicks tab, select each item you want to back up. You can also click Select 

None to clear all selections, or click Select All to select all of the items. When finished, click 
the Next button. 

(b) On the Local Folders tab, select each folder you want to back up and click Select.
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3. On the Items Selected for Backup screen, you can add more items or use 
advanced items as described in “Selecting all items from SmartPicks” on page 
31.

4. On the Items Selected for Backup screen, click the Next button.

Note: The Tally screen may appear. See “Selecting all items from SmartPicks” on page 31 for 
information about this screen.

5. Continue with “Completing the Backup Plan” on page 35.

Completing the Backup Plan

1. Name your backup plan and click the Next button. You can create additional 
backup plans by repeating the steps above. 
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2. A confirmation screen appears. Click Done.

3. A message explains that initial backup will use moderate resources on your 
computer. To pause the backup, click Pause until System Idle. 

4. To keep the backup running in the background, click Continue.

The WD Anywhere Backup screen displays the progress of the backup and the 
percentage of CPU used.
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When the backup finishes, the Backup Complete screen appears.

Alternatively, close the screen, click the WD Anywhere Backup icon, and select 
Show backup status.

As files are backed up, a small notification window appears.
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Restoring a Backup Plan

You can restore the files in your backup plan to a specified location in the event that 
you accidentally delete a file, want to compare file versions, or have lost all data due 
to a hard drive crash on your computer.

1. Click View and Restore. 

2. Click a backup plan in the Select a Plan list, or to search for a backup plan, 
enter the name in the Search by File Name field and click Search. 

3. Click the box(es) next to the folders or files you want to restore.

4. From the Restore Files to list, select a location for your restored files and click 
the Restore button. 
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Reactivating a Backup Plan

You may reactivate an old backup plan if you want to continue backing up the files 
specified in that plan.

1. On the menu bar, click Actions>Reactivate Backup Plan.

2. The Reactivate wizard appears. Click the Next button.
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3. Browse to select the location of the backup folder and click the Next button.

4. If you have more than one backup plan, select the one you want to reactivate and 
click OK.
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The following screen appears:

5. Select the No, just reactivate the backup plan and start backing up option 
and click the Next button. Your backup plan is reactivated, and your computer 
backs up files onto your selected backup destination.

Important: If you select the Yes option, all the files in your backup up plan 
are restored onto your computer. This overwrites the files on your computer 
with the files from your backup plan. See “Restoring a Backup Plan” on 
page 38.
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Editing a Backup Plan

Icons

Click the icons to add or remove files to and from backup plans, keep multiple 
revisions of files on hand for recall, remove entire plans, and view the backup log. 

Selecting a Backup Plan

If you have more than one backup plan, select the one you want by clicking in its box. 
A blue border surrounds the selected plan.

Changing Selected Files

1. On the WD Anywhere Backup screen, click the Change Selected Files icon. (See 
“Icons” on page 42.) The WD Anywhere Backup Configuration screen appears.

Note: To deselect all listed files, click the Select None link. To select all the listed files, click the 
Select All link.
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2. Do one of the following:
• To add files, click the Add Backup Items button.
• To remove files, select the files and click the Remove Selected Items button.
• To exclude files from the backup, click the Show Advanced Options button. 

Depending on your selections, subsequent screens may display. 

3. When you finish selecting items to add or remove, click the Select (or OK, 
depending on the screen) button. 

4. When returned to the WD Anywhere Backup Configuration screen, click the 
Done button. 

Changing Backup Plan Settings

You can change the number of versions of the same files WD Anywhere Backup 
should keep. For example, you may want to keep yesterday’s version as well as 
today’s version. 

1. Click the Change Selected Settings icon. (See “Icons” on page 42.) Select the 
Keep up to check box and enter the maximum number of earlier versions of your 
files to keep.

2. Click OK.

Removing a Backup Plan

You can delete a backup plan on the WD Anywhere Backup screen. Your backed up 
files remain at their destination until you delete them manually.

1. Click the Remove Backup Plan icon. (See “Icons” on page 42.)

2. In response to the confirmation message, click OK.

Showing the Backup and Error Logs

WD Anywhere keeps a log of all actions and backup errors.
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1. Select the backup plan, and click the Show Backup Log icon. (See “Icons” on 
page 42.) The Backup Log appears.

2. To view the error log, click the Error Log tab.

3. To cause an explanation of an error in the list displayed in the lower part of the 
screen, click the error.

4. To clear selected errors, select their check box and click the Clear Selected 
Errors button.

5. To clear all errors, click the Clear All Errors button.

6. To prevent the Error Log from displaying transient errors, click the Do not notify 
me about transient errors check box. This selection affects all backup plans.

7. To see which files have been backed up, click the click here to launch the WD 
Anywhere Restore application link. (For information on restoring, see 
“Restoring a Backup Plan” on page 38.)
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Using Time Machine™

The Apple® Time Machine™ is a built-in feature on Mac OS X Leopard and Snow 
Leopard computers that can back up everything on your computer: music, photos, 
documents, applications, e-mails, and system files. The My Book World Edition drive 
(firmware 1.00.28 and later) can store these backups, so that if your hard drive or 
operating system should crash, or you lose a file, you can easily restore it to your 
computer.

Setting up Time Machine

To set up Time Machine to back up files on your My Book drive:

1. Use one of the following methods to open Time Machine.
•  Click the Time Machine icon in the Dock. 

•  Click the Apple menu>System Preferences and select Time Machine.
•  Click Go>Applications and select Time Machine.

2. If this is your first time creating a backup, the following screen displays:

Click the Set Up Time Machine button to display the Time Machine 
Preferences screen. 
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3. Click the Choose Backup Disk button and select the My Book World Edition 
drive where you want the backups stored. 

4. Click the Use for Backup button. A screen prompts you for your user name and 
password. Enter wd_backup as the user name and backup as the password 
(not case-sensitive). 

5. Click the Connect button. The Preferences screen returns. 

6. To start automatic backups, move the slider to ON.
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7. To add a Time Machine drop-down menu to the menu bar at the top of the 
screen, select the Show the Time Machine status in the menu bar check 
box. This menu enables you to start a backup, enter Time Machine to restore files, 
or open the Time Machine Preferences screen. 

Time Machine begins backing up your files, but the first backup may take some 
time. Subsequent backups are faster because Time Machine only backs up new 
or changed items. A status bar displays the progress of the backup.

Time Machine backs up your computer every hour and keeps the following 
backup sets:

• Every hour for 24 hours

• Every day for the past month

• Weekly until the My Book drive is full.

If a backup is interrupted, for example, if the computer goes into sleep mode or 
the My Book drive is disconnected, it will resume automatically once the 
computer is available.

To see information such as available capacity and the date and time of the oldest, 
latest, and next backup, select Open Time Machine Preferences on the Time 
Machine drop-down menu:
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Starting a Backup

To start a backup at any time, select Back Up Now on the drop-down menu.

Restoring Backed-up Items

You may sometimes want to restore files and other items backed up on the My Book 
World Edition drive. For example, you may have lost a file, or you want to see files 
from a week ago. You can restore individual items, multiple items, folders, or if your 
system crashes, your entire hard drive.

To restore backed-up items to your hard drive:

1. Open the window on your computer where you want the item restored. For 
example, if you are restoring a document, open the Documents folder. (If you are 
restoring an item on your desktop, you do not need to open a window.)

2. Click the Time Machine icon in the Dock or select Enter Time Machine from 
the drop-down menu. 

All of your backups display in a cascade, with the most recent backup in the front. 
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3. Click the arrows or the time line on the right of the screen to browse through all 
the backups Time Machine has created.

4. Select the item you want to restore, and click the Restore button to display the 
following options:

5. Click the button for the desired option: 

Keep Original - Does not restore the item from the backup drive

Keep Both - The original item will remain and the backed-up item will be added 
to the selected location on your computer.

Replace - The backed-up item replaces the original item.

Time line

Scrolling
arrows

Restore
button

Cancel
button
U
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Deleting the Entire Backup

Time Machine enables you to delete your entire backup on the My Book World 
Edition drive. However, you cannot delete folders and files individually.

Note: In Finder, you will see a folder that corresponds to your backup drive and includes the word 
“backup”. This is a protected folder that is automatically created and where all of your backups 
reside. It serves no purpose for users other than to store Time Machine backups. In fact, if you try to 
connect to it, you will get a “Connection Failed” message.

To delete your entire backup:

1. In Finder, select the My Book World Edition drive and click the Connect As 
button. 

2. Enter wd_backup as the user name and backup as the password (not case-
sensitive) and click Connect. 
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The following screen displays.

3. Select the backup folder and then drag the *.sparsebundle file to the Trash icon.

Changing Your Password

You can change your default password for your My Book World to access Time 
Machine.

To change your password: 

1. Log in to the My Book World web user interface.

2. Enter your username and password and click Login (default username and 
password are “admin”).
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3. Click the Users button in Basic mode.

4. Click the icon to the right of the user name (WD_Backup). 

5. When the Users page appears, enter your new password in the New and 
Confirm password fields and click the Submit button
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6. A confirmation message displays. 
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MioNet® Remote Access

MioNet Overview

Remotely access your photos, music, documents, and videos from anywhere, anytime 
using MioNet secure remote access services from WD. MioNet makes remote file 
access and sharing seamless, simple and very secure. Just follow the steps to 
register your My Book World Edition into your secure MioNet account. Then you can 
access your content from any web browser in the world with your unique username 
and password. 

MioNet also enables you to share a folder of pictures on your My Book World Edition 
with friends (no upload required) or a folder of documents with your business 
colleagues. Invitees can only view the content you choose to share with them.

Remote Access Setup

My Book World Edition comes with MioNet enabled by default. The Remote 
Access menu in My Book World Edition’s Network Storage Manager allows you to 
further control the MioNet service on the storage device. See “Remote Access” on 
page 97 for further details. 

Windows

1. Turn on your computer and wait for the operating system to load.

2. Insert the My Book World Edition software CD into the CD-ROM drive.

Note: If AutoPlay is disabled on your computer, you must install the utilities manually. Click Start (or  on 
Windows 7) and then Computer (Windows Vista/Windows 7) or My Computer (Windows XP). Double-
click Setup.exe in the root directory of the CD.

3. Windows Vista/Windows 7: Click Run setup.exe and then Allow.

4. Click Accept in the Terms of Agreement screen.

5. If you have connected the device properly as shown in the Connect screen on 
page 12, click the Next button.
5
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6. Click the MioNet New Account button if you are a new MioNet user; click 
MioNet - Existing Account if you are an existing user. 

The MioNet registration screen appears.

7. Complete the registration form and click the Submit button to create an account.
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8. When MioNet finds the My Book World Edition you are registering, enter a name 
for the device and click OK. 

9. A confirmation message appears. Click OK.

MioNet displays a list of the public folders stored on your My Book World Edition 
and includes a private folder that was created with the MioNet username. 

On login, MioNet searches for any unregistered My Book World Edition units and 
gives any it finds a default name of WD Storage. MioNet names are independent 
of names assigned using My Book World Edition’s Network Storage Manager.
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Using MioNet Web (after registration)
1. From any browser, go to www.mionet.com/web and enter your username and 

password. The Quick Start tab appears, displaying icons representing activities 
you can perform. 

Note: In this User Manual, we discuss the most basic options. For more advanced options, see the 
MioNet Help or MioNet User Guide (available when you click the Online Help icon).

Accessing My Book World Edition Folders and Files Remotely 

Important: Local access to WD Storage using MioNet Web is not 
available. Use Window’s Explorer or Apple Finder.

1. Click the My Resources tab to display your My Book World Edition folders.
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Your My Book World Edition folders display in the My Resources tab of MioNet.

2. Select a folder to see a list of all the sub-folders and files. You can now use your 
browser to access your entire collection of music, photos, movies, and 
documents.

3. Double-click any file to open it locally. You may be able to drag and drop files from 
your My Book World Edition to the remote computer and vice versa.

Sharing Files with Others

Sharing Photos

You can easily share a folder of photos on your My Book World Edition with others. It 
is a simple three-step process. First you choose the folder you wish to share, then 
who you want to share with, and finally what permissions they have to access the 
folder.

1. Click the Share Photos icon.
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2. Choose any folder or the plus sign to choose a sub folder to share with someone 
else and click the Next button.

The screen for choosing people to share with appears.

3. To share photos with MioNet users you have shared with in the past:
(a) Select the user(s) and click the Next button. 

(b) Continue with step 6.

4. To add a new user to share with: 
(a) Click the Invite new person button.

(b) Enter the user’s e-mail address and click the Continue button. 

(c) Continue with step 6.
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5. To find another MioNet user you have never shared with before:
(a) Click the Find MioNet user button.

(b) Enter the user name or e-mail address of the user and click the Find button.

(c) When MioNet finds the user, click the Share with this person button.

(d) Continue with step 6.

6. From the list of users, select the user(s) you want to share with and click the Next 
button.

Note: You can press the Ctrl key in Windows or the Command key on the Mac to select multiple 
users.
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(e) Select the permission level and click the Finish button. If you want users to only view and 
download the photos, select Read permission. If you want to enable users to add photos (or 
modify or delete photos) to your folder, give them the Read & Write permission.

The person you invite receives an e-mail containing a link to MioNet. MioNet 
automatically opens up in the user’s web browser and provides instant secure 
access to the folder of photos on your computer.

Transferring Files to Others

MioNet enables you to transfer files to others to whom you have granted access, and 
to have them transfer files to you.

Note: MioNet transfers are not as fast as LAN transfers.

1. Click the Transfer Files to Others icon to open a dialog window showing your My 
Book World Edition folders.

2. Click the + to navigate through your directory to highlight the folder you wish to 
transfer files from and click the Next button.
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The following screen appears.

3. To transfer files back and forth with MioNet users you have shared with in the 
past:
(a) Select the user(s) and click the Next button. 

(b) Continue with step 6.

4. To add a new user to transfer files to and from: 
(a) Click the Invite new person button.

(b) Enter the user’s e-mail address and click the Continue button. 

(c) Continue with step 6.

5. To find a MioNet user you have never shared with before:
(a) Click the Find MioNet user button.

(b) Enter the user name or e-mail address of the user and click the Find button.
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(c) When MioNet finds the user, click the Share with this person button.

(d) Continue with step 6.

6. From the list of users, select the user(s) you want to transfer files to and from. 
Click the Next button.

Note: You can press the Ctrl key in Windows or the Command key on the Mac to select multiple 
users.

7. Select the permission level and click the Finish button. If you want users to 
transfer the files only to themselves, give them the Read permission. If you want 
to enable them to transfer files to you (or modify or delete your files), give them 
the Read & Write permission.

The user receives an e-mail containing a link to MioNet. MioNet automatically 
opens up in the user’s web browser and provides instant secure access to the 
folders or files on your computer. They can then double-click the file to open it 
and save it to their local PC.
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How to Play/Stream Video, Music & Photos

Media Server Overview

My Book World Edition is designed to serve as your home's central media hub. It 
enables you to stream photos, music, and videos to your home entertainment center 
and/or other PCs on your home network. 

The TwonkyMedia™ server application searches for the media in the three shared 
folders (Videos, Photos, and Music) stored on the My Book World Edition connected 
to your home network. The server is pre-set, so you can just transfer your multimedia 
content to the respective shared folders on your My Book World Edition (described 
on the next page), and you are ready to stream and view content on your home 
entertainment center, game consoles (for example, Xbox 360™, PlayStation® 3, or 
DLNA® 1.5 Digital Media Adapters, such as WD TV™ Live HD Media Player). Visit 
www.twonkymedia.com for further information on TwonkyMedia.

Media Types Supported

Note: Some devices may not support playback of all these files. Please refer to your device’s user 
manual to see which formats are supported.

Media Storage

You can access and store media content on My Book World Edition via network 
shares. Shares are folders that can be used to organize and store files on your 
My Book World Edition network storage system. Shares can be shared with everyone 
(public) or with selected users on your network (private). 

Shared Music Shared Videos Shared Pictures

Audio files Video files Image Files

MP3
WMA
WAV
LPCM
OGG vorbis
FLAC
M4A
M4B
MP4
3GP
AAC
MP2
AC3
MPA
MP1
AIF

MPEG1
MPEG2
MPEG4
AVI / DivX
WMV
VOB
3GP
VDR
ASF
MPE, 
DVR-MS
Xvid
M1V
M4V 

JPEG
PNG
TIF
BMP
GIF 
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The device comes pre-configured with the Public network share, which contains the 
following folders for media storage: 

• Shared Music - folder for storing music files you want to share with other users 
• Shared Pictures - folder for storing image files you want to share with other users 
• Shared Videos - for storing video files you want to share with other users 

Important: Do not change or delete these default share folders. 
Disruption of file sharing could result. These are the default folders for the 
Media Server (Twonky Media) and iTunes Service. For more information on 
how to use Twonky media, see “Media Server” on page 138. For more 
information on how to use the iTunes service, see “iTunes” on page 138.

How and where to add media content to the shared folders

1. Open the Internet Explorer.

2. Copy your music files to the Shared Music folder, which is under the Public folder 
on My Book World.

3. Follow the same process to place your videos and pictures into their respective 
Shared Pictures and Shared Video folders.

Important: Make sure to sort and add your media content to the 
corresponding shared folders. (e.g., music files must go into the Shared 
Music folders). If you do not do this, your content will not display correctly 
through your digital media adapter.
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Media Devices

Now that you have copied your files to their corresponding folders, you can use a 
variety of media devices to stream media. The following types are discussed in this 
section:

• Windows Media Player 11 (works with Windows Vista/Windows 7) on page 66.
• Windows Media Player 12 (comes with Windows 7) on page 66.
• WD TV Live HD Media Player on page 68.
• Xbox 360 - New User Interface on page 68.
• PlayStation 3 on page 71.
• Digital Picture Frames on page 71.
• Network Music Player on page 72.
• Digital Media Adapters on page 72.
• DLNA Devices on page 72.

Windows Media Player 11/12 (Windows Vista/Windows 7)

Note: Please go to the Microsoft Media Player support site for more information on using and 
updating your media player.

To stream media using Windows Media Player 11 or 12 Library:

1. Click Control Panel>Network and Sharing Center.

2. Click Customize.
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3. Select Private, and then click the Next button.

4. Launch Windows Media Player (Start>All Programs>Windows Media 
Player)

5. Click Library>Media Sharing. 
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6. Click Find media that others are sharing, and then click OK. 

7. Select a media type (Music, Pictures, or Video) and click PVConnect on 
MyBookWorld. 

8. Double-click the media file you want to play.

WD TV Live HD Media Player

You can connect the WD TV Live HD Media Player to your LAN network for access 
to media content stored in a network drive such as the My Book World Edition. 
Following are general steps for using the WD TV Live to access files on a My Book 
World Edition. 

Note: Please refer to your WD TV Live HD Media Player user guide for more specific instructions on 
connecting to the My Book World Edition and accessing and playing your media content.

1. Connect My Book World Edition to your LAN and power on the device.

2. Make sure the WD TV Live is connected to your TV and powered on.

3. Connect the WD TV Live to the LAN.

4. Navigate to Settings > Network setting > Network setup to choose the 
connection type.

5. Use the  navigation buttons to select Wired and press Enter.

Note: You can choose Wireless if you use a wireless adapter compatible with the 
WD TV Live. For a list of compatible adapters, please go to support.wdc.com and search the 
Knowledge Base for answer 3805.
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6. Select Automatic as the setup configuration option for DHCP or Manual for a 
static IP. 

7. A confirmation screen displays your WD TV Live’s network information if 
connection to the LAN is successful. Press Enter.

8. Navigate to the Home screen, and select the icon for media content you wish to 
access. It can be Music , Video , or Photo .

9. Press  /  to select Network Shares  or Media servers  and press 
Enter.

10.Press  /  to select the My Book World Edition and press Enter.
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Supported content for the selected media type displays. 

11.Select the content you wish to access, and then press Enter to start media 
playback.

Xbox 360 

Note: Please go to the Microsoft Xbox 360 support site for more information on using and updating 
your XBox 360.

1. Ensure that your Xbox 360 and My Book World Edition are powered on and 
connected to your local area network.

2. From the main Xbox user interface, scroll to the My Xbox screen

3. Use the Xbox 360 controller and scroll to the right until you see Video, Music and 
Picture Library options.

4. Select any one of these three options by pressing the A button on your controller. 
The Select Source screen displays.

5. Select the MyBookWorld option based on the device name you created 
previously and press the A button. You see the media content stored on your 
MyBookWorld unit.

6. Using the controller, scroll through to view and play your media content.
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PlayStation 3

Note: Please go to the Sony® PlayStation support site for more information on using and updating 
your PlayStation.

1. Ensure that your PlayStation 3 and My Book World Edition are powered on and 
connected to your local area network. You see the main user interface with a 
series of options displayed horizontally across your TV screen.

2. Using the directional buttons (left and right) on the PS3 controller, navigate to 
Music, Photo or Video depending on which type of media you want to play, and 
press the X button.

3. Using the directional buttons (up and down), scroll and select MyBookWorld (or 
the new device name that you created previously) by pressing the X button. You 
now see a list of folders (Music, Photo and Video) to the right of the 
MyBookWorld icon.

4. Make sure that you select the folder that corresponds to option you selected back 
in Step 2. For example, if you select Photo from the main user interface screen, 
open the corresponding Photo folder to the right of the MyBookWorld icon; 
otherwise your content does not display properly.

Digital Picture Frames

The following are general steps for setting up digital photo frames:

1. Ensure that your My Book World Edition is connected to your home’s local 
network and is powered on.

2. Follow the user instructions provided with your wireless digital photo frame to 
proceed through any initial setup or installation of drivers.

3. Using the navigation feature on your wireless digital photo frame, scan and detect 
the My Book World Edition on your network.

4. Depending on the brand of photo frame you have, you may need to access 
Settings/Network Setup page in the user interface to establish connection so that 
your photo frame can link to your My Book World Edition. Please refer to your 
digital photo frame’s user guide for specific instructions.

5. Once you have a connection between your wireless photo frame and the My 
Book World Edition, access the Media screen on your photo frame that provides 
you the option to view your pictures.

Note: Please refer to your wireless photo frame user guide for supported picture file formats and 
instructions on accessing and viewing your pictures.
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Network Music Player

The following are general steps for using a network music player to access My Book 
World Edition:

1. Connect My Book World Edition to your local area network and power on the 
device.

2. Connect and configure your network music player on your home’s wired or 
wireless network switch or router.

3. Turn on your network music player.

4. If connected properly, you find the device name of your My Book World Edition.

5. Navigate through the network music player’s user interface to locate and play 
music stored on your My Book World Edition.

Note: Please refer to your network music player user guide for specific instructions on connecting to 
a network attached storage system and how to access and play your media content.

Digital Media Adapters

The following are general steps for using a Digital Media Adapter (DMA) to access to 
My Book World Edition:

1. Connect My Book World Edition to your local area network and power on the 
device.

2. Make sure that your DMA device is connected to your TV and powered on. The 
main screen of your DMA device displays.

3. Depending on the DMA device, you may need to access the Settings/Network 
Setup screen in the user interface to establish a connection between your DMA 
and My Book World Edition. Please refer to your DMA’s user guide for specific 
instructions.

4. Once you have a connection established between your DMA and My Book World 
Edition, access the Media screen on your DMA to view your pictures or stream 
music and video content from the My Book World Edition.

Note: Please refer to your DMA’s user guide for specific instructions on connecting to the My Book 
World Edition and how to access and play your media content.

DLNA Devices

See specific DLNA media device user manuals for instructions on connecting a 
DLNA device to your local area network so you can access content on My Book 
World Edition. Go to www.dlna.org for a list of DLNA-certified devices and for further 
information.
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Using iTunes with My Book World Edition

iTunes Media Server Overview

With the iTunes Media Server, you or anyone connected to the My Book World 
Edition can use iTunes to play music files stored on it. This service creates a virtual 
music library on the device and treats it as an iTunes repository, making it possible for 
music files to stream from the My Book World Edition to Windows or Mac computers 
running iTunes. 

Media Types Supported

The iTunes Media Server supports the following file types:

• *.mp3
• *.wav
• *.aac

Note: The iTunes server requires the presence of the ‘/Public/Shared Music’ share folder. Do not 
rename or delete Shared Music if you want to use the iTunes server. You must recreate or rename 
the ‘/Public/Shared Music’ folder if it has been deleted or renamed.

Storing Content

You can drag and drop audio files to My Book World Edition’s ‘/Public/Shared Music’ 
default folder.

Streaming Audio in iTunes

The iTunes Media Server is enabled by default in the Network Storage Manager 
utility. See “To enable or disable the iTunes Server:” on page 139 for more 
information.

1. Launch iTunes on your computer.

2. Click MyBookWorld under the Shared section of the left pane. If you have 
copied music to the /Public/Shared Music folder and it is in a format supported 
by iTunes, it should be listed in the right pane.
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3. Double-click an audio file to play.   

The audio file is streamed in iTunes and audio files from the My Book World 
Edition are displayed under the Shared list.
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Using WD Discovery (Windows only) 

WD Discovery is a proprietary utility that aids in connecting to WD network drives. 
The easy-to-use software enables you to quickly locate and set up the My Book 
World Edition from any Windows computer on your network. With WD Discovery, 
you can easily map network drives, browse shared folders, and create a desktop 
shortcut for quick access to your My Book World Edition.

WD Discovery provides the following options:

Mapping a Network Drive

To access and store data on My Book World Edition after setting up the device, you 
must first map a network drive to one or more of the default shares. You must install 
the WD Discovery application on each Windows XP, Windows Vista, or Windows 7 
computer in your network to automatically map a network drive, browse network 
shares, or create a desktop shortcut.

Windows XP/Windows Vista/Windows 7

Note: Follow the steps below only if you have not installed WD Discovery as instructed in “Using 
WD Discovery with Windows XP/Windows Vista/Windows 7” on page 12.

1. Turn on your computer and wait for the operating system to load.

If WD Discovery is not running:

For Windows XP, click Start>Programs>WD Discovery or double-click the 
WD Discovery icon on your desktop. 

For Windows Vista, click Start>Programs>WD Discovery Software>WD 
Discovery or double-click the WD Discovery icon on your desktop.

For Windows 7, click the Windows icon  and then All Programs>WD 
Discovery Software>WD Discovery or double-click the WD Discovery icon 

Configure your My Book World Edition device using the 
My Book World Edition’s Network Storage Manager interface. 
See “Network Storage Manager: Basics” on page 81.

Automatically map a network drive so you can easily share and 
store data on your My Book World Edition. See “Automatic Drive 
Mapping” on page 76.

Easily browse network shares without having to manually enter 
network paths. See “Browse Network Shares” on page 77.

Create a desktop shortcut that points to a networked My Book 
World Edition. See “Desktop Shortcut Creation (Windows only)” 
on page 79.
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on your desktop. 

WD network drives are listed in the Network Drives Found list.

2. Click the device you want to map in the Network Drives Found list and click 
Map Network Drive in the Things to Do list.

A message appears asking whether you want to map the drive automatically. 
Continue with “Automatic Drive Mapping” below or “Manual Drive Mapping” 
on page 77. 

Automatic Drive Mapping

1. After completing step 2 above, click Yes.

All share folders available on the device are mapped as network drives 
automatically. Available drive letters are assigned backwards from Z. 

When mapping completes, the share folders appear as network drives in the 
WD Discovery screen. 

2. Click Back to return to the main page.
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Manual Drive Mapping

1. After completing step 2 of “Mapping a Network Drive” on page 75, click No. All 
share folders on the device are listed on-screen. Select a folder name, and then 
select a drive letter. 

2. Click Yes to complete drive letter assignment.

3. Click My Computer on Windows XP and Computer on Windows Vista/
Windows 7. The network drives display. You can now drag and drop files into the 
network drive folders using My Computer or Windows Explorer.

Browse Network Shares

To access data on a share using WD Discovery:

Use WD Discovery to easily browse network shares without having to manually enter 
network paths.

1. Ensure that the device is powered on and connected to the network. 

2. Do one of the following: 

For Windows XP, click Start>All Programs>WD Discovery Software>WD 
Discovery or double-click the WD Discovery icon on your desktop. 

For Windows Vista, click Start>Programs>WD Discovery Software>WD 
Discovery or double-click the WD Discovery icon on your desktop.

For Windows 7, click the Windows icon  and then All Programs>WD 
Discovery Software>WD Discovery or double-click the WD Discovery icon 
on your desktop.

3. Click MyBookWorld in the Network Drives Found list and click Browse 
Network Shares in the Things To Do list. 
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4. After successful login, the share folders on the device are listed. Click a network 
share path to view and access share files in Windows Explorer. 

5. Copy your music files into the Shared Music folder, your video files into the 
Shared Videos folder, and your photos and pictures into the Shared Pictures 
folder. 
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Desktop Shortcut Creation (Windows only)

WD Discovery can create a desktop shortcut that points to a networked 
My Book World Edition. 

To create a desktop shortcut:

1. Ensure that the device is powered on and connected to the network. 

2. For Windows XP, click Start>All Programs>WD Discovery Software>WD 
Discovery, or double-click the WD Discovery icon on your desktop. 

For Windows Vista, click Start>Programs>WD Discovery Software>WD 
Discovery, or double-click the WD Discovery icon on your desktop.

For Windows 7, click the Windows icon  and then All Programs>WD 
Discovery Software>WD Discovery, or or double-click the WD Discovery 
icon on your desktop.

3. Click MyBookWorld in the Network Drives Found list, and then click Create 
Desktop Shortcut in the Things To Do list. 

4. A dialog appears informing you that the desktop shortcut has been created 
successfully. Click OK.
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Automatically Updating WD Discovery

When you open WD Discovery, the WD Discovery Auto Update Progress screen 
may appear, notifying you that an update to WD Discovery is available.

To download the update:

1. On the WD Discovery Auto Update Progress screen, click Yes.

A message indicates that the download may take several minutes.

When the update is complete, a confirmation message appears:

2. To launch WD Discovery, click Yes.
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Network Storage Manager: Basics
My Book World Edition’s Network Storage Manager is a powerful and convenient 
user interface for managing and configuring your My Book World Edition.

Note: Accessing and setting up the My Book World Edition’s Network Storage Manager is not 
required to begin using your My Book World Edition right away.

This chapter explains how to configure the My Book World Edition, access My Book 
World Edition’s Network Storage Manager, and enter basic settings. For instructions 
on configuring advanced settings, see “Network Storage Manager: Advanced Mode” 
on page 101.

Configuring My Book World Edition

Follow the instructions below to configure your My Book World Edition for Windows 
or Mac.

Windows XP/Windows Vista/Windows 7

Note: Follow the steps below only if you have not installed WD Discovery Tool as instructed on 
page 12. Otherwise, launch WD Discovery Tool using the desktop icon and continue with step 6.

1. Turn on your computer and wait for the operating system to load.

2. Insert the software CD into the CD-ROM drive.

Note: If AutoPlay is disabled on your computer, you must install the utilities manually. Go to 
Computer (Windows Vista/Windows7) or My Computer (Windows XP). Double-click Setup.exe 
in the root directory of the CD.

3. Windows Vista/Windows 7: Click Run setup.exe, and then click Allow.

4. Click Accept in the Terms of Agreement screen.

5. If you have connected the device properly as shown in the Connect screen, click 
the Next button. (See “Using WD Discovery with Windows XP/Windows Vista/
Windows 7” on page 12.)

6. The Application Installer screen opens, displaying a list of options. Click WD 
Discovery Tool.
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7. The WD Discovery screen displays. Click MyBookWorld in the Network 
Drives Found list and click Configure.

8. The login page appears. Continue device setup by following the instructions for 
“Setting Up the Device for the First Time” on page 83.

Mac OS X

1. Turn on your computer and wait for the operating system to load.

2. Open the Safari web browser.

3. Click the Bookmarks link in the upper left corner of the screen.

4. Click Bonjour, and then double-click MyBookWorld.

5. The login page appears. Continue device setup by following the instructions for 
“Setting Up the Device for the First Time” on page 83.

Note: The Mac OS X Leopard (10.5.6) may not be able to get past the login page. Please go to 
support.wdc.com and search the knowledge base for answer ID 3280, which has instructions on 
correcting the problem. 
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Setting Up the Device for the First Time

Follow the steps below to continue setting up the device on all operating systems.

Note: You only have to perform this step the first time you log in to the My Book World Edition. 

1. Enter “admin” in both the Administrator Name and Password fields. 

2. Select a language from the Language list and click the Login button.

3. Click the Next button. 

4. Read the license agreement, and then click the I Agree button. 
NETWORK STORAGE MANAGER: BASICS - 83



MY BOOK WORLD EDITION
USER MANUAL
5. In the Initial Setup page, do the following:
(a) Enter a name in the Device Name field (up to 15 characters, including alphanumeric and 

dash ‘-’).

Note: The device name is used to identify the storage device connected to the network. To connect 
more than one storage device to the same network, you must specify a unique device name for each 
storage device. 

WARNING: Renaming My Book World Edition forces all the 
network computers to remap their shared network resources. 
Change the device name only when necessary.

(b) Enter a brief description of the device in the Device Description field. The maximum length 
of the description is 42 alphanumeric characters. 

(c) Select a time zone from the Time Zone list. 

(d) If necessary, adjust the date and time manually using the Date & Time lists. 

6. Click the Next button.

7. Enter a new admin password in the New Admin Password field. The maximum 
length of the password is 16, including alphabetic, numeric, underscore, space, 
and most special characters except double-quote ("). The first and last characters 
cannot be a space. The password is case sensitive.
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8. Retype the new password in the Confirm Password field. Click the Next 
button.

Note: If you forget your admin password, you must reset the device to its default configuration using 
the reset button. See “Reset Button” on page 8 for instructions.

9. Do one of the following:
(a) Accept the default DHCP (Dynamic Host Configuration Protocol) client settings. 

(b) If you are not using DHCP, click Static and manually assign the IP address. Click the Next 
button. 
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10.The Summary page displays. Click the Finish button. 

Note: If you are using Windows XP, Windows Vista, or Windows 7, you may notice a warning notice 
bar display during the final initialization of your My Book World Edition. The bar warns that the 
Internet Explorer has blocked an Active X controller message. This warning disappears on its own, or 
you can click the X button to the right of the bar. This warning does not affect setting up your drive.

The login page redisplays.

Accessing My Book World Edition’s Network Storage Manager

Important: You must configure My Book World Edition before using 
Network Storage Manager. Follow the instructions under “Configuring My 
Book World Edition” on page 81.

Once you have performed the initial setup, you can access the Network Storage 
Manager through the web user interface. 

Note: Accessing and setting up the Network Storage Manager is not required to begin using your 
My Book World Edition.

Windows XP/Windows Vista/Windows 7

1. Ensure that the device is powered on and connected to the network. 

2. If WD Discovery is not running:

3. For Windows XP click Start>All Programs>WD Discovery Software>WD 
Discovery, or double-click the WD Discovery icon on your desktop.

For Windows Vista, click Start>Programs>WD Discovery Software>WD 
Discovery or double-click the WD Discovery icon on your desktop.

For Windows 7, click the Windows icon  and then All Programs>WD 
Discovery Software>WD Discovery or double-click the WD Discovery icon 
on your desktop.

Click MyBookWorld in the Network Drives Found list and point to and click 
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Configure in the Things To Do list.

4. The login page appears. Type in the administrator name and password (the 
default password is “admin” unless it has already been changed by the 
administrator). In the Tool list, click Network Storage Manager. In the 
Language list, click the language for your region. Click the Login button. 

Mac OS X

1. Turn on your computer and wait for the operating system to load.

2. Open the Safari web browser.

3. Click the Bookmarks link in the upper left corner of the screen.

4. Click Bonjour, and then double-click MyBookWorld.

5. The login page appears. Type in the administrator name and password. In the 
Tool list, click Network Storage Manager. In the Language list, click the 
language for your region. Click the Login button.

My Book World Edition’s Network Storage Manager Features

The web-based management utility includes the following features:

• LAN access—the device supports local area network access of the web-based 
user interface, enabling management from anywhere in the network. 

• Secured access—the device can be accessed and configured by the 
web-based, password protected user interface over SSL (Secure Socket Layer).

• E-mail notification—in the event of warnings or errors related to temperatures, 
hard drive, network, or USB connection, administrators are automatically alerted 
by e-mail.

• Multiple access levels—users can be assigned different rights. The device 
supports two levels: full access and read only.

• Update via web—firmware updates can be downloaded and installed on the 
device from a computer on the LAN.

• Disk management—the web-based user interface allows administrators to 
monitor internal hard drives and USB hard drives connected to the device. 
Support for file sharing—allows file sharing over the network.

• USB storage support—allows reliable data transfer from a USB storage device 
to the device.

• Support for file sharing—allows file sharing over the network.
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• RAID management (My Book World Edition II)—allows RAID configuring of 
the hard drives. 

• Support for Windows and Mac systems—allows users on different platforms 
to share files using CIFS (Common Internet File System), NFS (Network File 
System), FTP (File Transfer Protocol), and AFP (Apple Filing Protocol) protocols.

• iTunes streaming support—enables users connected to the device to stream 
music to supported media adapters. 

• Twonky media server—provides fast, convenient navigation and searching of 
all your media files in the Twonky user interface.

• Remote shutdown or reboot—allows administrators to power off or reboot the 
device from any computer on the LAN.

• System log—an efficient instrument in analyzing and solving technical issues. 

User Interface Overview

The web-based user interface is designed to logically access and manage the 
features of the device. Upon logging in, the web user interface defaults to Basic 
Mode. Basic Mode provides access to the most common device configuration 
options. 
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The Advanced Mode home page includes six tabs, and each tab is subdivided into 
several icons providing advanced task management functions. The toolbar located on 
the upper right allows you to switch between Advanced Mode and Basic Mode any 
time. 

Note: See “Network Storage Manager: Advanced Mode” on page 101 for instructions on using 
Advanced Mode.

Toolbar

The toolbar located on the upper right of the Network Storage Manager user 
interface includes the following commands.

Function Description

Advanced Allows you to switch the user interface from Basic to Advanced Mode. 

Basic Allows you to switch the user interface from Advanced to Basic Mode. 

Help Displays online help. 

Logout Exits the utility. 
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Basic Mode

The Basic Mode home page provides access to the most common configuration 
options. 

Click any of the buttons to display the available configuration options. The table 
below describes the options. 

Device Name 

Use this option to enter or change a device name and/or a description of the device. 
The device name is the name by which your My Book World Edition is identified on 
the LAN. 

Category Description

Device Name Enter a device name and description. For more details, see “Device Name” on page 90.

Date & Time Set the system date and time manually or set the NTP server to allow date and time to be 
updated automatically. For more details, see “Date & Time” on page 91.

Network Configure the network connection. For more details, see “Network” on page 92.

Users Create and delete user accounts and change the user password. For more details, see 
“Users” on page 93.

Folder Shares Access configuration details relating to how shares are made available through this storage 
device. This menu also displays a list of mounted volumes and their available shares. When a 
USB hard drive is connected to the device, the USB hard drive displays as USB share. For 
more details, see “Folder Shares” on page 95.

System Status Displays general information about the storage device, such as device name, firmware version, 
current date/time, system uptime, IP address, volume usage, and volume RAID type. For more 
details, see “System Status” on page 97.

Remote Access Enables or disables the MioNet function. Computers running MioNet can remotely access and 
share files on the storage device over the Internet. For more details, see “Remote Access” on 
page 97.

Shutdown/
Reboot

Performs device shutdown or reboot from any computer on the local area network (LAN). For 
more details, see “Shutdown/Reboot” on page 100.
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1. Click Device Name in the Basic Mode home page.

2. Enter or change the text in the Device Name and/or Device Description fields.

3. Click the Submit button. 

Date & Time 

The date and time are synchronized automatically to the NTP (network time protocol) 
server by default. You have the option to set the date and time manually or allow the 
NTP to access the Internet to automatically set the time. 

Note: Time displays in 24-hour format only.

1. Click the Date & Time button on the Basic Mode home page.

2. Deselect Enable to set the time manually.

3. To synchronize the date and time automatically, click Enable.
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4. Click the Submit. button.

Network 

The device’s network option is set to DHCP Client by default, which is appropriate 
for most environments. By selecting Static IP, you can manually set the IP address, 
netmask, gateway, and DNS (Domain Name Service) server IP address.   

To configure the network settings:

1. Click the Network button on the Basic Mode home page.

2. In the Network Mode drop-down menu, select a network mode. Selecting DHCP 
Client as a network mode causes the device to obtain an IP address 
automatically from the local DHCP server. Selecting Static IP as a network 
mode requires you to enter IP information such as IP address, Default Gateway, 
and DNS Servers. 

3. Click the Submit button. 
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Users 

This option enables the administrator to control access to data on the My Book 
World Edition across the network by creating user accounts with specific 
permissions. The administrator can also edit and delete user accounts. 

Users Page Icons 

To create a new user account:

1. Click the Users button on the Basic Mode home page.

2. Click the Add icon . 

Important: We recommend that you use the same user name and 
password as you use to log in to Windows.

3. Enter the user name in the User Name field.

4. Enter the user’s full name in the Full Name field. 

5. Enter the password in the Password field.

Note: The password can contain up to 16 characters, including alphabetic, numeric, underscore, 
space, and most special characters except double-quote ("). The first and last characters cannot be 
a space. The password is not case sensitive. 

6. Re-enter the password in the Confirm Password field. 

Icon Description

Private share disabled.

Private share enabled.

Click this icon to change the user password. 

Click this icon to delete a user. 

Click this icon to add a user. 
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7. Create a private user share at the same time by clicking Yes next to Create User 
Private Share. The new user is granted full access to the private share. The 
private share name is the same as the user name.

8. Click the Submit button. 

To change a user password:

1. Click the Users button on the Basic Mode home page.

2. Click the Change Password icon  next to the appropriate user account. 

3. Make the necessary changes, and then click the Submit button. 

To delete an existing user account:

1. Click the Users button on the Basic Mode home page.

2. Select the user account you want to delete, and then click the Delete icon .
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3. Click OK.

For more user configuration options using the Network Storage Manager Advanced 
Mode, see “Users” on page 140.

Folder Shares 

Shares are folders that can be used to organize and store files on your 
My Book World Edition network storage system. Shares can be shared with everyone 
(public) or with selected users on your network (private). 

The device comes preconfigured with three shares: 

• Public—created automatically at the factory 
• Shared Music - folder for storing music files you want to share with other users. 

• Shared Pictures - folder for storing image files you want to share with other users. 

• Shared Videos - for storing video files you want to share with other users. 

Important: Do not change or delete these default share folders. 
Disruption of file sharing could result. These are the default folders for the 
Media Server (Twonky Media) and iTunes Service. For more information on 
how to use Twonky media, see “Media Server” on page 138. For more 
information on how to use the iTunes service, see “iTunes” on page 138.

• Download—for saving files using Downloader (see “Download Manager: 
Downloader” on page 151).

• Configuration—this is a read-only share containing only a Help file and the login 
page. It is not meant for sharing or storing data and should not be modified.

The administrator can create private shares accessible only by user name and 
password when setting up a user account (see “To create a new user account:” on 
page 93), or by setting permissions on an existing share (see “Folder Share 
Permissions” on page 143).
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The Folder Shares menu provides access to a list of available shares.

Folder Shares Page Icons 

To create a share:

1. Click the Folder Shares button on the Basic Mode home page.

2. Click the Add icon . 

3. Enter a share name in the Share field. The share name can contain up to 32 
characters, including alphabetic, numeric, or underscore characters.

4. Enter a brief description in the Description field.

5. Click the Submit. button. 

Icon Description

 Private share disabled.

Private share enabled.

Click this icon to delete a share. 

Click this icon to add a share. 
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To delete existing shares:

WARNING: Deleting a share erases all data on the share. All files and 
folders on the share will be lost.

1. Select the share to delete. 

2. Click the Delete icon .

3. Click OK.

System Status 

The System Status button displays general information about the system: device 
name, firmware version, current date/time, system uptime, IP address, volume usage, 
and volume RAID type. Click the System Status button on the Basic Mode home 
page to access system information.

Remote Access 

My Book World Edition comes with MioNet enabled by default. The Remote 
Access button enables you to control the MioNet service on the storage device. If 
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MioNet is not already set up through the web, follow the instructions in “MioNet® 
Remote Access” on page 54. 

MioNet Icons 

• Start/Stop MioNet - Displays Stop MioNet if MioNet is running; displays Start 
MioNet if MioNet is stopped.

• Restart MioNet - Reboots MioNet.
• Reset MioNet - Resets MioNet account information on the My Book World 

Edition. If the My Book World Edition is registered to a MioNet account, that 
registration is erased so that the unit is now unregistered. This status is displayed 
in the upper right corner of the page. Any shares created by MioNet or MioNet 
users remain, and no data is lost. Access to these shares over the LAN requires 
the use of the MioNet username and password.

MioNet Service Status Messages

• MioNet service connection status
• Started - MioNet service is started

• Stopped - MioNet service is stopped and will start on system restart. 

• Disabled - MioNet service is disabled and will not start on system restart.

MioNet Registration Status 

• Unregistered - Not currently registered to a MioNet account

• Registered - Already registered to a MioNet account

Note: A mouse-over of the registration status shows the MioNet account name if the device is 
registered. To register with MioNet, go to: www.mionet.com/MyBookWorld.
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To register with MioNet:

1. Click the Create MioNet account link in the note at the bottom of the page. The 
MioNet web registration page displays.

2. Enter the registration information required and click the Submit button.

To log in to an existing MioNet account:

1. Click the MioNet login link at the bottom of the page.

2. Enter your MioNet username and password and click the Go button.
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Shutdown/Reboot 

The Shutdown/Reboot button allows you to perform a system reboot or shutdown.

To perform My Book World Edition shutdown:

1. Click Shutdown/Reboot in the Basic Mode home page.

2. On the Shutdown/Reboot page, click Shutdown. 

3. Click OK.

To perform My Book World Edition reboot:

1. Click the Shutdown/Reboot button on the Basic Mode home page.

2. On the Shutdown/Reboot page, click Reboot. 

3. Click OK. 
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Network Storage Manager: Advanced Mode
Advanced Mode provides access to additional features not available in the Basic 
Mode. When in Basic Mode, click Advanced Mode on the toolbar to view Network 
Storage Manager in Advanced Mode.      

The Advanced Mode home page include six tabs, each having several buttons 
providing more management options for maximum flexibility and security of the 
device. The table below describes the tab options available in Advanced Mode. 

Tab Description

System The System tab allows you to configure the general system settings, set e-mail or system 
alerts, change the administrator password, perform firmware upgrades, perform system 
configuration file backups, restore system to factory defaults, activate or deactivate the 
system LEDs, generate an SSL certificate, enable power saving, and perform device 
shutdown or reboot. For more details, see “System Tab” on page 102.

Network The Network tab has access to all network configuration options, such as setting DHCP / 
Static mode, changing the IP address, netmask, gateway, DNS server IP address, configuring 
jumbo frames, and configuring membership in a domain or workgroup. For more details 
“Network Tab” on page 115. 

Storage The Storage tab provides a list of all supported drives on the system. It also allows you to 
configure the RAID capability of the hard drives (My Book World Edition II only), manage file 
share preferences, set the backup destination folder, set disk quotas, and set a share folder 
for users. For more details, see “Storage Tab” on page 122.

Media The Media tab allows you to enable or disable the streaming option in iTunes or to access the 
Twonky Media server. For more details, see “Media Tab” on page 137.

Users The Users tab allows you to add, modify, and delete users and groups, and change all user 
and group permissions (read/write, read only, no access) to shares/folders and USB storage 
devices. For more details, see “Users Tab” on page 140. 

Status The Status tab displays general information about the system such as device name, firmware 
version, current date/time, machine uptime, memory and swap activity, and load averages. 
This tab also allows viewing of logs from the system, Common Internet File System (CIFS), or 
File Transfer Protocol (FTP). For more details, “Status Tab” on page 147.
10
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System Tab

The System tab allows you to set the system date and time, set up alerts, change 
the admin password, perform firmware upgrades, create a backup copy of the 
system files, restore system to factory defaults, generate and set up an SSL 
certificate, or perform system reboot or shutdown. 

The System tab provides access to the following configuration options: 

• General Setup 
• Alerts Setup
• Admin Password
• Update
• Restore Configuration 
• Advanced
• Shutdown/Reboot

General Setup 

The General Setup button on the System tab allows you to perform basic 
configuration of the device. Here, you can change the name and description for the 
device, select a compatible web access protocol, and set the time zone. You can set 
the date and time manually or enable automatic time synchronization via NTP 
(Network Time Protocol) Service. You can also manually specify the IP address of the 
NTP servers to which you want to synchronize.
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To configure system general setup settings:

1. Assign a device name for this storage device in the Device Name field. The 
device name can contain up to 15 characters, including alphabetic, numeric, and 
hyphens only.

2. Enter the brief description for this storage device in the Device Description field. 
The maximum length of the description must not be more than 256 alphanumeric 
characters.

3. For Web Access Protocol, select either of the following web access protocols:
• Hypertext Transfer Protocol (HTTP) is a communications protocol for the transfer of 

information on the intranet and the World Wide Web.

• Hypertext Transfer Protocol over Secure Socket Layer or HTTPS is a URL scheme 
used to indicate a secure HTTP connection. All traffic between the managing computer and 
the My Book World Edition is encrypted. It is syntactically identical to the http:// scheme 
normally used for accessing resources using HTTP. HTTPS provides a more secure means of 
configuring your device, but may affect the responsiveness of the user interface.

4. To set the date and time manually, deselect Enable next to NTP Service. 

5. Select a time zone from the Time Zone list. 

6. Adjust the date and time manually in the Date & Time lists. 

7. Click the Submit button.

Alerts Setup 

Using the Alerts Setup button on the System tab, you can configure e-mails or 
popup messages that provide alerts for system conditions, over temperature; hard 
drive, volume, network, and USB status; and user and group events. These alerts 
help the system administrator(s) manage and detect events or errors.
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Note: E-mail alerts may not work with some ISPs using strong spam filtering. For further information, 
go to support.wdc.com and search the knowledge base for answer ID 2570. 

To set up automatic e-mail notifications:

1. On the Alerts Setup page on the System tab, click Enable next to E-mail 
Notification.

2. In the SMTP Server field, enter the name or IP address of the SMTP server used 
for e-mail. (Check with your Internet Service Provider (ISP) for the SMTP server 
settings, which may include the SMTP port, and ask whether to enable TLS / SSL 
or SMTP authentication.)

3. In the Email Return Path field, enter a valid return e-mail address recognized by 
your ISP. For example, if your SMTP server is "smtp.myisp.net", then you should 
enter a valid return e-mail path address of the form "myname@myisp.net". 

4. In the Email Recipients field, enter the e-mail address where you want to send 
an e-mail message when an event occurs. Up to five e-mail addresses can be 
used at a time. 

5. Click Send Test Mail to send a test alert and confirm your settings are correct. 
A test message is sent to each entered e-mail address.
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6. Click the Submit button.

To configure alerts to send pop-up messages when an event occurs:

Note: Pop-up notification only works with Windows XP. 

For a list of events, see “System Events” on page 177.

1. On the Alerts Setup page on the System tab, click Enable next to Pop-Up 
Notification. 

2. Enter the name of the computer in the Notified Devices field. When an event 
occurs, a pop-up message appears on the computer. Up to five computer names 
can be added to the alert list.

Note: To find the name of your computer, click Start and right-click Computer or My Computer, 
click Properties, and then click the Computer Name tab (Windows XP).

3. Click Send Test Pop-up to send a test alert and confirm that the settings are 
correct.

Note: Make sure the Messenger Service is activated on the computers to which you want to send 
the pop-up message when an event occurs. To enable Messenger Service, go to Start>Control 
Panel>Administrative Tools>Services>Messenger. You can test the Messenger Service by 
clicking Send Test Pop-up. Make sure printer and file sharing is selected as an exception if the 
Windows Firewall is enabled.
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4. Click the Submit button 

Admin Password

The Admin Password button on the System tab allows you to change the 
administrator’s password. 

To change the administrator's password:

1. Click the Admin Password button on the System tab.

2. In the Old Password field, enter the old password.

3. In the New Password field, enter the new password. The maximum length of the 
password is 16, including alphabetic, numeric, underscore, space, and most 
special characters except double-quote ("). The first and last characters cannot 
be a space. The password is case sensitive.

4. In the Confirm Password field, re-enter the new password.

5. Click the Submit button.
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Update (Firmware)

The Update button on the System tab provides information about the current 
firmware version and allows you to perform a firmware update either automatically or 
manually.

Automated

The Automated tab provides information about the current firmware version and 
connects to the WD website for automatic downloading of the latest firmware. 

1. Click the Update button on the System tab. The Automated page displays.

2. Click Check For New Firmware. 

3. Click Download if new firmware is available. 
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The Network Manager page indicates progress. 

When the download is finished, the following page displays:

4. Click Upgrade. Wait for the update process to complete. 

WARNING! Do not interrupt a firmware upgrade in progress; doing so 
may cause the device to malfunction or render it unable to boot.

After your firmware has been updated, the device reboots. The user interface 
redirects to the System Information page after the update has completed.

Manual

 The Manual page allows you to install the firmware manually.   

1. Before attempting a manual update, check support.wdc.com for firmware 
availability.

2. If a new firmware file is available, obtain it from WD Technical Support at 
support.wdc.com.

3. Save the file to a Desktop location on your computer. 

4. Click the Manual tab on the Update page.
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5. Under Firmware Update, click the Browse button and locate the firmware file 
you saved.

6. Click the Submit button. 

A page with a progress bar and a warning displays.

WARNING! Do not interrupt a firmware upgrade in progress; doing so 
may cause the device to malfunction or render it unable to boot.

After your firmware has been updated, the device reboots. The web user interface 
redirects to the System Information page after the update is completed.

Note: If the IP address of your unit has changed, you need to use WD Discovery Tool to discover it 
again.
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Restore Configuration

The Restore Configuration button on the System tab allows you to save or 
restore system configuration settings or revert to factory default settings.

The single-drive My Book World Edition displays the following page:
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The My Book World Edition II (2 drives) displays the following page, which has a 
Full Restore button:

To back up the current system configuration settings:

1. On the Restore Configuration page, click Save Current Configuration. 

2. Click Save. 

3. Specify a file name and location for saving the file. 

4. Click Save. 

To restore saved configuration settings:

1. On the Restore Configuration page, click Browse. 

2. Select the previously saved system configuration file. 

3. Click Open.

4. Click General Restore. Selecting General Restore restores all features to 
previously saved settings (data volume and shares settings excepted). All current 
system configurations are lost. 
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5. My Book World Edition II: On the two-drive unit, you have the option of clicking 
Full Restore to restore all features, including the data volume and shares, to 
previously saved settings. All current system configurations and user data are lost 
when using Full Restore.

6. Click OK. 

To restore the device to factory defaults:

Important: Save the current configuration prior to restoring the factory 
default settings. 

Performing a factory default reset erases all settings in the My Book World Edition. 
System configuration resets the device to default factory settings. All information 
and data will be lost. The LAN settings (including port settings) are not changed. 
After the reset, the administrator login/password is changed to “admin/admin.”

1. On the Restore Configuration page, click Restore Factory Default. 

2. Click OK. 

During the system restore process, the system turns off the power LED and blinks 
the backup LED. Wait until the system restore process is completed. 

Note: You cannot access the configuration web pages if you forget the administrator password, IP 
address setting, or device name. Use the reset button to restore these settings (including IP setting, 
device name, and administrator password) to factory default configuration. To use this function, 
press and hold the reset button on the back of the device (next to power interface) for at least 10 
seconds. The system reboots automatically and you can then use the default settings to access the 
device. 

Advanced 

Configure the system for root access, SSL certificate/key, power saving, and LED 
control using the Advanced button on the System tab home page. 

To open the Advanced page:

1. Click the Advanced button on the System tab home page. 

To enable SSH access:

Secure Shell (SSH) is a network protocol that uses encryption and authentication 
keys to enable two devices on the network to exchange data securely. Enabling SSH 
access allows login to a console window using SSH for diagnostic use. The default 
root user password is displayed for the user.
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1. On the Advanced page, select the Enable check box under Root Access. 

2. Click the Submit button. 

To generate an SSL certificate and key pair automatically:

Configure the system for a secure connection by generating a key and an SSL 
certificate automatically or manually. 

1. On the Advanced page on the System tab home page, click the highlighted word 
“HERE” in the Auto Generate field of the SSL certificate/key. The SSL 
Certificate/Key Generation dialog appears.   

2. Enter the identification information you want to include in the SSL certificate/key 
pair, and then click the Submit button.
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To generate an SSL certificate and key pair manually:

1. Using your preferred method, generate an RSA private key and paste it in the 
appropriate fields on the Advanced page.

2. Click the Submit button.

To disable HDD standby (enabled by default):

If the HDD Standby function is enabled, the hard drives go into standby mode to save 
power after a fixed period of no activity. This period varies from two to seven minutes. 

1. On the Advanced page, clear the Enable check box next to HDD Standby.

2. Click the Submit button.

To disable LED control (enabled by default):

The LED indicator function can be enabled or disabled using LED control. LED status 
is enabled by default. Follow these steps to turn off LED control:

1. On the Advanced page, clear the Enable check box next to LED Status.

2. Click the Submit button.

Shutdown/Reboot 

The Shutdown/Reboot button allows you to perform system reboot or shutdown.

To shut down the My Book World Edition:

1. Click the Shutdown/Reboot button on the System tab home page.

2. On the Shutdown/Reboot page, click the Shutdown button. 

3. Click OK.
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To reboot the My Book World Edition:

1. Click the Shutdown/Reboot button on the System tab home page.

2. On the Shutdown/Reboot page, click the Reboot button. 

3. Click OK. 

Network Tab

The Network tab provides access to the following configuration options:

• LAN
• Services
• Workgroup
• Remote Access
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LAN 

The LAN button on the Network tab home page allows access to all network 
configuration options including setting the connection method, changing the IP 
address, netmask, gateway, and DNS (Domain Name Service) server IP address, as 
well as changing the MTU size to enable jumbo frames (My Book World Edition II 
only).

To configure the network settings:

1. Click the LAN button on the Network tab home page.

2. In the Network Mode drop-down menu, select a network mode. Selecting 
DHCP Client as a network mode causes this storage device to obtain an IP 
address automatically from the local DHCP server. Selecting Static IP as a 
network mode requires you to assign IP information such as IP address, default 
gateway, and DNS servers. 

3. If your network link speed is 1000 Mbps in the MTU Size menu, enter the MTU 
(Maximum Transmission Unit) value for the jumbo frame. The default MTU setting 
for Jumbo Frames is 1500 bytes. The network card on the client computer must 
support jumbo frame.

Note: For the MTU size larger than '1500', the client machine and the network switch must also 
support the same MTU size. The common MTU size for jumbo frame is '9004'. The rule for 
calculating valid MTU is (MTU size - 1500) mod 8 = 0 ('xxx mod 8' means the value 'xxx' can be 
divided by 8). 
The range of valid IP addresses for each class: 
- Class A: 1.0.0.1 to 126.255.255.254 
- Class B: 128.1.0.1 to 191.255.255.254 
- Class C: 192.0.1.1 to 223.255.254.254 

4. Click the Submit button. 
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Services 

The Services button on the Network tab home screen allows you to set protocols 
for sharing files and folders on the device. 
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• Universal Plug and Play (UPnP)—Set of computer network protocols that 
simplifies the implementation of networks in the home by allowing devices to 
connect seamlessly.

• File Transfer Protocol (FTP)—Network protocol used to transfer data from one 
computer to another through a network. FTP is a popular choice for exchanging 
files independent of the operating systems involved.

• Network File System (NFS)— Network file system protocol that allows a user 
on a client computer to access files over a network as easily as if the network 
devices were attached to its local disks. Generally used on UNIX systems.

• Apple File Protocol (AFP)— Network protocol that offers file services for Mac 
computers. AFP is enabled by default.

• Web Access
• Hypertext Transfer Protocol (HTTP)—Communications protocol for the 

transfer of information on the intranet and the World Wide Web.

• Hypertext Transfer Protocol over Secure Socket Layer or HTTPS— 
URL scheme used to indicate a secure HTTP connection. It is syntactically 
identical to the http:// scheme normally used for accessing resources using 
HTTP.

To enable UPnP NAT Traversal for Web Access & FTP:

1. Below UPnP for Web Access & FTP, click Enable for Service.

2. Click the Submit button. 

The UPnP NAT Traversal combines with the UPnP feature and NAT feature. 
Universal Plug and Play (UPnP) is an architecture for pervasive peer-to-peer 
network connectivity of PCs and intelligent devices. The Network Address 
Translation (NAT) is used in gateway devices that form the boundary between the 
public Internet and the private LAN. As IP packets from the private LAN traverse 
the gateway, NAT translates a private IP address and port number to a public IP 
address and port number, tracking those translations to keep individual sessions 
intact. 

To enable other network services:

1. Click Enable beside the desired network service. 

2. If you have selected FTP as your network service, click Yes to enable or click No 
to disable anonymous login, and then click the Submit button. 

3. If you have selected NFS or AFP as your network service, the IP allowed field 
appears. You are prompted to enter the IP filters that are allowed for NFS service. 
Click the Add button to add a new IP filter, and then click the Submit button. 

Note: In IP Allowed field of NFS service, '*' means allow all IP addresses. If you intend to allow 
specified IP addresses or range, please modify '*' in IP Allowed field. 
Mount point for NFS share is /nfs/SHARENAME, Ex. /nfs/Public. 

4. You can specify particular port numbers for HTTP, HTTPS, and FTP services 
respectively. Instead of selecting Default, you can specify the port number 
between 8000 and 10000 for each service.
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To access data via FTP:

You can access data in a shared folder on My Book World Edition with a widely used 
FTP client software program. An FTP client software program must be installed on 
the computer you are using to access the device, and FTP service must be enabled 
on the My Book World Edition (see “To enable other network services:” on page 118 
and “To modify properties of the share:” on page 131 for details).

1. Open an FTP client software program.

2. Enter ftp://username@IP address as the host name 
(e.g., ftp://admin@172.25.102.67) or just the device’s IP address depending on 
the FTP client software program you are using.

Note: Click System Status in either the basic or Advanced Mode to view the device's IP address.

3. Enter the My Book World Edition user name and corresponding password.

4. Click the Connect or OK button.

You can now upload files to or download files from My Book World Edition across the 
LAN. It is possible to upload files to or download files from My Book World Edition 
across the Internet (WAN), but this requires custom router configuration and is 
recommended only for advanced users.

Workgroup 

The Workgroup button on the Network tab home page allows you to set up the 
network storage device as a workgroup or a domain member. The default setting is 
Workgroup. 

Domains are controlled from a central location (domain controller) and require central 
authentication before you can join them. Workgroups, in contrast, are much simpler 
to control. As long as you know the workgroup name, you can add any computer to a 
workgroup.

If your network uses a domain (has a Windows 2003 Active Directory Service (ADS), 
you may wish to connect this device as a domain member. When configured as a 
domain member, the device asks the ADS to authenticate users. Therefore, as a 
domain member, the device provides user-level security. 

ADS enables the administrator to manage users’ permissions in a central location 
and to propagate these permissions to multiple devices. For example, any device that 
has a domain on ADS inherits the user list and associated permissions.

When joining a domain, the device must be authorized by the domain's administrator. 
You must enter the fully qualified Domain Name, Domain Controller IP Address, 
Domain Administrator Name, and Domain Administrator Password for the 
authorization. 
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To set up a workgroup name:

1. Click the Workgroup button on the Network tab home page.

2. Click Workgroup as the Mode option. 

3. Enter a name for your workgroup in the Workgroup Name field. 

4. Click the Submit button. 

To join a domain (Windows 2003 Server only):

1. Click Domain Member. 

2. Enter the domain name in the Domain Name field. 

3. Enter the domain controller IP address in Domain Controller IP Address field. 

4. Enter the domain administrator name in the Administrator field. 

5. Enter the domain administrator password in the Administrator Password field. 

Note: The local user and domain user share the same access control rights if the user name of the 
local and domain users are the same (FTP service excluded).

6. Click the Submit button. 
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When the process is complete, a confirmation message appears.

If changes are made at the Active Directory server to either users or groups or 
both, you can manually update the list on the WD My Book World Edition. (See 
“Folder Share Permissions” on page 143.)

Remote Access 

My Book World Edition comes with MioNet enabled by default. The Remote 
Access button on the Network tab home page allows you to control the MioNet 
service on the storage device, If MioNet is not already installed on the client 
computer, follow the instructions in “MioNet® Remote Access” on page 54. 

MioNet Icons 

• Start/Stop MioNet - Shows Stop MioNet if MioNet is running; shows Start 
MioNet if MioNet is stopped.

• Restart MioNet - Stops MioNet if it is running and starts it again.
• Reset MioNet - Resets all MioNet account information on the My Book World 

Edition. If the My Book World Edition is registered to a MioNet account, that 
registration is erased so that the unit is now unregistered. This status is displayed 
in the upper right corner of the page. Any shares created by MioNet or MioNet 
users remain, and no data is lost. Access to these shares over the LAN requires 
the use of the MioNet username and password.

MioNet Service Status Messages

• MioNet service connection status
• Started - MioNet service is started

• Stopped - MioNet service is stopped and will start on system restart. 

• Disabled - MioNet service is disabled and will not start on system restart.

MioNet Registration Status 

• Unregistered - Not currently registered to a MioNet account

• Registered - Already registered to a MioNet account

Note: A mouse-over of the registration status shows the MioNet account name if the device is 
registered. To register with MioNet, go to: www.mionet.com/MyBookWorld.
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You can create a new account or log in to an existing account on this page. (For more 
information about MioNet, see “MioNet® Remote Access” on page 54.

To register a new Web account with MioNet:

1. Click the Create MioNet account link in the note at the bottom of the page. The 
MioNet registration page displays.

2. Enter the registration information required and click the Submit button.

To log in to an existing MioNet account:

1. Click the MioNet login link at the bottom of the page.

2. Enter your MioNet username and password and click Go. 

Storage Tab

The Storage tab provides all necessary options required for individual storage disk 
configuration and maintenance. This tab also includes an option to change the 
system’s RAID configuration (My Book World Edition II only), set a share name, and 
format and safely remove the USB hard drives connected to the system. 

The Storage tab provides the following configuration options:

• Disk Manager
• Volumes & RAID Management
• Folder Shares
• USB Shares
• Quota 
• Downloads
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Disk Manager 

The Disk Manager button on the Storage tab home page displays the installed 
hard drives in the device. This page also displays detailed information about the hard 
drives, such as disk size, disk description, and status. 

Drive status messages include the following:

• Good—Indicates the hard drive is accessible and functioning normally. 
• Failed—Indicates a fatal error has occurred on the hard drive(s). See “Replacing 

a Drive (My Book World Edition II)” on page 169 for drive replacement 
instructions. 

• Foreign—Indicates the device has detected a hard drive that was used on 
another computer. 

To clean up disk:

If the hard drive is foreign or used, the Clean Disk  icon appears on the right side 
of the Disk Management table. Clean Disk erases the previous partition to allow 
creation of a new volume. 

To safely remove disk:

If the hard drive is not part of an existing volume, the Safely Remove Disk  icon 
appears on the right side of the Disk Management table and allows you to safely 
remove the drive. 
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Volumes and RAID Management 

The Volumes and RAID Management button on the Storage tab home page 
provides one tab, Volume Status, for the My Book World Edition and two tabs, 
Manage Volume and Manage RAID, for the My Book World Edition II. 

Manage Volume (My Book World Edition)

The Volume Status page lists all the volumes available on the device and provides 
detailed information about each volume such as volume name, volume type, disk or 
disks associated with the volume, usage, total size, and volume status.

Volume status messages include the following:

• Good—Indicates the volume is accessible and hard drive is functioning normally. 
• Failed—Indicates a volume cannot be started automatically, the disk may be 

damaged or the file system may be corrupt. 
• Formatting—Indicates volume is being formatted or system is creating an ext3 

(third extended) file system for a Linux operating system. 
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Manage Volume (My Book World Edition II)

The Manage Volume tab lists all the volumes available on the device and provides 
detailed information about each, such as volume name, volume type (RAID type), disk 
or disks associated with the volume, usage, total size, and volume status. 

Note: For My Book World Edition II, if the volume RAID type is JBOD and there are new disks in the 
system, the Extend icon appears on the side of the Manage Volume table.

Volume status messages include the following:

• Good—Indicates the volume is accessible and hard drive is functioning normally. 
• Failed—Indicates a volume cannot be started automatically, the disk may be 

damaged or the file system may be corrupt. 
•
• Formatting—Indicates volume is being formatted or system. 
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Manage RAID (My Book World Edition II)

Configure RAID on the hard drives using the Manage RAID tab on the Volume & 
RAID Management page. The default RAID configuration is RAID 1 (Mirrored).

WARNING! Changing the RAID configuration causes all volumes and 
data to be lost. 

RAID (Redundant Array of Independent Drives) refers to an array of multiple 
independent hard drives that provide high performance and reliability. RAID function 
depends on the number of drives present and the RAID level selected. 

The My Book World Edition supports the following RAID levels: 

• RAID 0 (Striped)—Provides data striping (spreading out blocks of each file 
across multiple hard drives) but no redundancy. This improves performance but 
does not deliver fault tolerance. If one drive fails then all data in the array is lost. 

• RAID 1 (Mirrored)— Provides disk mirroring. Mirroring creates an exact copy (or 
mirror) of a set of data on two drives, which increases reliability compared to a 
single drive. If either drive fails, the other continues to function as a single drive 
until the failed drive is replaced. Note this RAID type has the highest disk 
overhead (100%) of all RAID types. 

• Span (Spanned)—Combines drives into a linear fashion to create one large 
logical volume. Unlike RAID 0, which “stripes” all data bitwise to both drives, the 
volume is linear across both drives. A spanned drive is literally like a single bigger 
drive, in that files written to the volume earlier go to the “beginning” of the volume, 
on the first physical drive. As the volume fills, files written later are written toward 
the “end” of the volume, on the second drive. Like RAID 0, no data redundancy is 
provided. If one of the drives fails, all data is lost. 

• JBOD (Just a Bunch of Disks)—In JBOD mode, two drives are provided as two 
separate volumes. This is the only mode on the My Book World Edition II for 
which there are two data volumes. If one of the drives in a JBOD volume fails, only 
the user data on that volume is lost.
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To configure the Manage RAID tab:

Warning: Be sure to back up all data before configuring RAID. All data 
stored in the hard drive is lost when changing the RAID configuration. 

1. Click the Manage RAID tab on the Volumes & Raid Management page. 

2. Select a RAID configuration: 

• DataVolume is the default volume. 

• If the volume RAID type is JBOD and there are new disks in the system, the 
Extend icon appears on the side of the Volume Management table. 

3. Click the Submit button. 
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Manage RAID Options (My Book World Edition II)

Any existing mode can be changed to any other available mode using the Manage 
RAID option. The following table provides the available modes and data availability for 
a My Book World Edition II with one drive after adding a second drive.

All “1 Drive” configurations for the My Book World Edition II are considered 
“Degraded” RAID modes. When a drive fails in a My Book World Edition II with two 
drives, the following table applies regarding the user data on the remaining good 
drive.

Starting Configuration Ending Configuration User data condition after second 
drive added

JBOD (1 Volume) Spanned (Linear) Deleted

JBOD (1 Volume) JBOD (two volumes) Still available

JBOD (1 Volume) RAID 0 (Striped) Deleted

JBOD (one volume) RAID 1 (Mirrored) Deleted

RAID 1 (Mirrored) Spanned (Linear) Deleted

RAID 1 (Mirrored) JBOD (two volumes) Deleted

RAID 1 (Mirrored) RAID 0 (Striped) Deleted

RAID 1 (Mirrored) RAID 1 (Mirrored) Still available after rebuild

Starting Configuration User data condition after one drive fails

Span (Linear) All user data is lost

JBOD User data on good drive still accessible

RAID 0 (Striped) All user data is lost

RAID 1 (Mirrored) User data on good drive still accessible, but with 
no data redundancy
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Folder Shares 

Shares are folders that can be used to organize and store files on your 
My Book World Edition. They can be shared with everyone (public) or with selected 
users on your network (private). 

The device comes preconfigured with three shares: 

• Public—created automatically after initial setup 
• Shared Music - folder for storing music files you want to share with other users. 

• Shared Pictures - folder for storing image files you want to share with other users. 

• Shared Videos - folder for storing video files you want to share with other users. 

Important: Do not change folder names or delete these default share 
folders. Disruption of file sharing could result. These are the default folders 
for the Media Server (Twonky Media) and iTunes Service. For more 
information on how to use Twonky media, see “Media Server” on page 138. 
For more information on how to use the iTunes service, see “iTunes” on 
page 138.

• Download—For saving files using Downloader (see “Download Manager: 
Downloader” on page 151).

• Configuration—Read-only share containing only a Help file and the login page. 
It is not meant for sharing or storing data and should not be modified.

When setting up a user account, the administrator can create private shares 
accessible only by user name and password (see “To create a new user account:” on 
page 93), or by setting permissions on an existing share (see “Folder Share 
Permissions” on page 143).
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The Folder Shares button on the Storage tab home page provides access to a list 
of available shares. 

USB share naming corresponds to the following configuration: 
usb1-<port number>share<partition number>

The port number is always “1” since My Book World Edition has only one USB port.

To create a share:

1. Click the Add icon  to display the following screen:

2. Enter a share name in the Share field. The share name can contain up to 32 
characters, including alphabetic, numeric, or underscore characters.

3. Enter a brief description in the Description field.
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4. Click a file sharing protocol next to Services. The My Book World Edition 
supports the following file sharing services (protocols):
• CIFS (Common Internet File System) - Allows access to share files via the CIFS 

protocol. The access control for CIFS is set as share-based. This means that a user must 
enter a valid account and password for accessing the share, and users can only access the 
shares to which they have been granted access rights (Read Only or Full Access). CIFS is 
the recommended file sharing protocol for Windows platform, and allows users to access 
shares through My Network Places. Mac OS X or later also supports the CIFS protocol. 

• File Transfer Protocol (FTP) - a network protocol used to transfer data from one computer 
to another through a network, such as the Internet, using an FTP client program. FTP is a 
popular choice for exchanging files independent of the operating systems involved.

• Network File System (NFS) - a network file system protocol that allows a user on a client 
computer to access files over a network as easily as if the network devices were attached to 
its local disks.

Note: For FTP and NFS, enable manually on the Advanced Mode Network Services page. 

• Apple Filing Protocol (AFP) - the network protocol for sharing files and file services in an 
AppleTalk network.

5. Select a logical volume you want to share from the Volume list (default is 
DataVolume). 

6. (Optional) Click Setup access control after creating this share to enable 
access control for the new share. My Book World Edition II has an Extended 
Volume option with JBOD. For more information, see “To edit the access rights of 
users or groups:” on page 144.

7. Click the Submit button. 

To modify properties of the share:

Note: Properties for the Public and Download shares cannot be modified or deleted.

1. On the initial Folder Shares list, select the share you want to modify, and then 
click the Modify icon . 

2. Edit the share name if desired. The share name can contain up to 32 characters, 
including alphabetic, numeric, or underscore characters.
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3. Edit the brief description if desired.

4. Select a file sharing protocol. 

5. Click the Submit button. The initial Folder Shares page returns.

To delete existing shares: 

1. On the Folder Shares list, click the Delete icon  after the share name.

2. Click OK.

USB Disks 

When a USB storage device with the FAT, HFS+J, or NTFS file system is connected 
to the network storage device, the USB device displays as a USB share.

USB Disk

Use the USB Disks button to format or safely disconnect a USB drive.

To format a USB drive:

1. Connect a USB drive to the device.

Note: The My Book World Edition supports USB flash disk and external USB drives; USB optical 
drives (CD/DVD combo or DVD dual/multi drive) are not supported.

For instructions on how to connect a USB drive to the My Book World Edition, 
see “Click the Submit button to apply the changes.” on page 162.

2. Click the Format icon  to the right of the USB. A dialog box appears warning 
that all data will be erased.
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WARNING! Formatting hard drives erases all the disk contents, 
including partition tables, logical volumes, and all shared folders and 
subfolders and files. Perform this procedure only when it is safe to 
proceed. When formatting a USB drive, only one partition is created and 
the partition is formatted as FAT32. With FAT32, only 4 GB can be 
copied for each file. If you try to transfer files that are larger than 4 GB, 
you may encounter a Copy Termination error.

3. Click OK.

4. Do not disconnect the USB disk from the My Book World Edition until formatting 
is complete. 

To safely remove a USB drive:

Note: Whenever a USB device is disconnected without first being ejected or dismounted, there is a 
risk of data loss or damage to the USB drive. With the safe remove disk option you can safely 
remove any USB drive attached to the device.

1. On the USB Disks page, click the Safely Remove Disk icon  to the right of the 
USB device name. 

2. Click OK.

Quota 

The Quota button on the Storage tab home page allows administrators to enable or 
disable quota control for the device and set grace time and quota limits for each user. 

Quota is used to limit the maximum storage capacity for each user. The accumulated 
files or folders used in a volume for the specified user cannot exceed the quota 
setting. Once the user data exceeds the quota, a 7-day (by default) grace period 
commences. The user still can store up to 100 MB of additional data on the volume 
within the grace period. When the grace period expires, the user cannot store 
additional data on the volume until deleting the amount of data required to reduce the 
total capacity used below the quota setting.
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Manage Quota

The Manage Quota tab in the Quota Management page provides the quota 
information for each volume and allows administrators to modify the quota settings. 

Note: Use the Manage Quota tab to enable quota, and use the DataVolume User Quota tab to 
enable quota per user.   

To configure disk quota:

1. Select the volume you want to modify, and then click the Modify icon . 

2. Click Enable next to Quota Service to enable disk quota service. 

3. Specify the grace period after which no additional drive space is provided. 

4. Click the Submit button. 
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DataVolume User Quota (or ExtendVolume User Quota)

The DataVolume User Quota tab provides user quota information details and 
allows administrators to modify the user quota setting if two or more volumes are 
available. If a My Book World Edition II is set to JBOD, the ExtendVolume User Quota 
tab is available instead. 

To modify the user quota setting:

1. Select the volume you want to modify, and then click the Modify  icon. 

2. Click Enable next to Quota Service to enable disk quota service. 

3. Specify the quota size for the user. 

4. Click the Submit button. 
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Downloads 

The Downloads button on the Storage tab home page provides two tabs—Setup 
Destination Share and Change Password. They provide configuration options for 
selecting the Downloads destination share for scheduled downloads and changing 
the Downloader login password. This login provides non-administrator users with a 
method to download files directly to the My Book World Edition. For more information 
on how to use the Downloader utility, refer to “Download Manager: Downloader” on 
page 151.

Set up Destination Share

Use the Setup Destination Share tab to choose the target share for the 
Downloader utility. 

To set the destination share name for the Downloader:

1. On the Downloads page, click the Setup Destination Share tab. 

2. Select the folder to share with others from the Destination Share list. 

3. Click the Submit button. 

Note: If no destination is selected, the download utility is disabled. For instructions on using the 
download utility, see “Downloader Features” on page 152.

Change Password

The Change Password tab allows you to change the Downloader’s password. 

To change the Downloader’s password:

Note: The default password is “downloader.” The user name is always “downloader.”

1. On the Downloads page, click the Change Password tab. 

2. Enter a password in the Change Password field. The maximum length of the 
password is 16, including alphabetic, numeric, underscore, space, and most 
special characters except double-quote ("). The first and last characters cannot 
be a space. The password is case sensitive. 
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3. Re-enter the password in the Confirm Password field. 

4. Click the Submit button. 

Media Tab

The Media tab provides access to the iTunes and Media Server menus. 

Note: The Media Server and iTunes servers only work on the LAN.
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Media Server 

The TwonkyMedia 5.1 server application searches for all the media (for example, 
videos, photos, and music) stored on the My Book World Edition connected to your 
home network. The server is pre-set, so you can just transfer your multimedia content 
to the respective shared folders on your My Book World Edition, and you are ready to 
stream and view content on your home entertainment center, game consoles (for 
example, Xbox 360, PlayStation 3, or DLNA 1.5 Digital Media Adapters), and other 
PCs on your home network. Visit www.twonkymedia.com for further information on 
TwonkyMedia. 

iTunes

Enable the iTunes Server and customize its settings using the iTunes menu. iTunes 
Server allows iPod and iTunes users to share and play music on the My Book World 
Edition. 

Note: iTunes Server is enabled by default.

With the iTunes Server, you or anyone connected to the My Book World Edition can 
use iTunes to play music files stored on it. The iTunes Server creates a virtual music 
library on the device and treats it as an iTunes repository, making it possible for music 
files to stream from the My Book World Edition to Windows or Mac computers 
running iTunes. 

The iTunes Server supports only the following file types:

• *.mp3
• *.wav
• *.aac

Note: The iTunes Server requires the presence of the ‘/Public/Shared Music’ share folder. Do not 
rename or delete Shared Music if you want to use the iTunes Server. You must recreate or rename 
the ‘/Public/Shared Music’ share if it has been deleted or renamed.
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To enable or disable the iTunes Server:

1. On the iTunes server page, click Enable next to iTunes Service. Or, deselect 
the option to disable it. 

2. Specify how often iTunes will scan the device for new music files (default is 30 
minutes). 

3. Click the Submit button. 

To customize media library update frequency:

1. Select an option in the Check for new music every list. 

2. Click the Submit button.

To stream audio in iTunes:

1. Make sure that the iTunes Server is enabled in the Network Storage Manager 
utility. See “To enable or disable the iTunes Server:” on page 139 for more 
information.

2. Click MyBookWorld under the Shared section of the left pane. If you have 
copied music to the /Public/Shared Music folder and it is in a format supported 
by iTunes, it should be listed in the right pane.

3. Double-click an audio file.   

The audio file is streamed in iTunes and audio files from the My Book World 
Edition are displayed under the Shared list.

Note: Both the Media Server and the iTunes Server only work on the LAN. 
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Users Tab

The Users tab provides access to the following configuration options:

• Users
• Groups
• Folder Share Permissions
• USB Share Permissions

Users 

The Users button on the Users tab home page allows administrators to create, edit, 
and delete user accounts from Access Control list management. 

To create a new user account:

With this feature, you can create user accounts on the My Book World Edition and 
further customize these accounts with privilege levels. 
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1. On the Users page on the Users tab, click the Add icon  to display the 
following page:

Note: The user name and password can contain up to 15 characters, including alphabetic, numeric, 
underscore, space, and most special characters.

2. Click Grant Administration Rights to provide the user with administrative 
rights. Administrative rights allow the user to configure the device.

Note: The password can contain up to 16 characters, including alphabetic, numeric, underscore, 
space, and most special characters except double-quote ("). The first and last characters cannot be 
a space. The password is case sensitive.

3. Enter the user name in the User Name field.

4. Enter the user’s full name in the Full Name field. 

5. Enter the password in the Password field.

6. Re-enter the password in the Confirm Password field. 

7. If desired, select a previously created Group for the user to join from the Group 
List. 

8. Click the >> button to add the selected user to the group. 

9. You may create a private user share at the same time by clicking Yes next to 
Create User Private Share. The new user is granted Full Access to the private 
share. The private share name is the same as the user name. Nobody else has 
access to this private share unless it is specifically granted by the administrator.

10.Select a volume that you want the user to access. (My Book World Edition II only)

11.Select one or more file sharing protocols to access private shares. 

12.Click the Submit button. 
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To modify a user account:

1. On the Users page on the Users tab, select the user account to modify, and then 
click the Modify icon . 

2. Make the desired changes, and then the Submit button. 

To delete an existing user account:

1. On the Users page on the Users tab, click the Delete icon to the right of the user 
account you want to delete .

2. Click OK.

Groups 

The Groups button on the Users tab home page enables the administrator to create, 
edit, and delete a group from Access Control list management. 

To create a group:

1. On the Groups page on the Users tab, click the Add icon  to display the 
following page:

2. Assign a new group name. 

3. Enter a description of the new group.
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4. Select users from the User List field to add to the User Joined field. 

5. Click the >> button. 

6. Click the Submit button. 

To modify a group:

1. On the Groups page on the Users tab, select the group account you want to 
modify, and then click the Modify icon . 

2. Make the necessary changes, and then click the Submit button. 

To delete a group:

1. On the Groups page on the Users tab, select the group you want to delete, and 
then click the Delete icon .

2. Click OK.

Folder Share Permissions 

The Folder Shares Permissions icon on the Users tab home page enables you to set 
the access control for each user or group in the Access list. 

• Public Access 

• Full Access  

• Read Only  

• Deny Access  

• Not Assigned 

When there is a conflict in the access rights of the user and group, the My Book 
World Edition uses the following rules to handle the conflict:

• Deny Access has the highest priority. 
• Full Access + Read Only = Full Access. 

If the access control is assigned to users or groups, the full access, read only, and no 
access icons appear on the Share Access page. You can move your mouse over the 
icon to view the user or group list. 
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To edit the access rights of users or groups:

1. Select a user or group on the Folder Shares Permissions page, and then click the 
Edit icon  to display the following page:

2. Click Enable next to Public Access allow everyone to access to the share. 

3. Select an access option. 

4. In the Unassigned Users list, select the users to whom you want to grant full 
access, read only permission, or no access to the share. 

5. Click the >> button.

6. In the Unassigned Groups list, select the local groups to which you want to 
grant full access, read only permission, or no access to the share. 

7. Click the >> button.

8. Click the Submit button.

Note: Public shares can be accessed using the administrator name and password as well as by a 
guest name and password. The default guest name and password are both “guest.”
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USB Share Permissions 

The USB Shares button on the User tab enables you to set access control for the 
two USB ports on the back of the device. 

The types of access control that you can assign to a user or group include: 

• Public

• Full Access  

• Read Only  

• Deny Access  
• Not Assigned 

When there is a conflict in the access rights of the user and group, the device uses 
the following rules to handle the conflict: 

• Deny Access has have the highest priority. 
• Full Access + Read Only = Full Access. 

If the access control is assigned to users or groups, the full access, read only, and no 
access icons appear on the Share Access page. You can move your mouse over the 
icon to view the user or group list.
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To edit the access rights of users or groups:

1. Select the share you want to modify by clicking the Edit  icon next to that 
share. The following page appears if Public Access is enabled: 

If Enable is not selected, the following page displays:

2. Click Enable next to Public Access to allow everyone to access the share. 

3. Select an access option.
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4. In the Unassigned Users list, select the users to whom you want to grant full 
access, read only permission, or no access to the share. 

5. Click the >> button.

6. In the Unassigned Groups list, select the local groups to which you want to 
grant full access, read only permission, or no access to the share. 

7. Click the >> button.

8. Click the Submit button.

Status Tab

The Status tab provides access to the following configuration options. 

• System Status
• System Logs

System Status 

The System Status button on the Status tab home page displays general 
information about the system: device name, version, current date/time, system 
uptime, IP address, volume usage, and volume RAID type if RAID is functioning 
properly. If RAID is not healthy, the RAID/Volume Usage field displays “failed”.
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System Logs 

The System Logs button on the Status tab home page displays the events 
recorded by the System Configuration utility. You can view information such as file 
and services requested on the device and requests between the device and client 
computers. You can also change the order and number of the log entries shown in 
log pages. 

System

The System subtab displays system logs on the device.

The System Logs record events that occur in the system. You can obtain information 
from the following conditions or errors that may occur in the system components and 
hardware or software components. 
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• System shutdown
• System reboot
• Factory default restore failed
• System temperature exceeds a threshold value
• Disk SMART failure
• Volume failed or does not exist
• Volume space is full or close to 100%
• Unsafe removal of a USB mass storage device
• Resync volume failed

The following types of events are logged:

• Critical—An event such as system temperature has exceeded the threshold 
level, Disk SMART failed, volume space is full or close to 100%, extend volume 
failed, or resync volume failed. When a critical event occurs, the power/system 
status LED lights up and the system records events in the System Log. 

• Warning—An event that is not necessarily significant, but may indicate a 
possible future problem. An e-mail or pop-up message alert is sent to notify user 
of the problem that occurred in the system. 

• Information—An event that describes the successful operation of an 
application, driver, or service. 

CIFS

The CIFS (Common Internet File System) subtab displays logs of file and services 
requested on the device for connections that use this protocol. 
NETWORK STORAGE MANAGER: ADVANCED MODE - 149



MY BOOK WORLD EDITION
USER MANUAL
FTP

The FTP (File Transfer Protocol) subtab displays logs of the requests and records 
transferred between the device and client computers for connections that use this 
protocol. 

Settings 

The Settings subtab assigns the order and number of log entries that appear on the 
Logs page. 

To configure the log settings:

1. On the Settings tab, click Show log entries in reverse order to display the 
most recent entries at the top.

2. Enter the number of entries you want to appear on the System, CIFS, and FTP 
logs.
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Download Manager: Downloader
Downloader has two powerful tools for managing downloads directly to the unit: 
HTTP/FTP and CTorrent. These tools are great for when you want to download very 
large or multiple large files from the Internet and do not want to sit and wait for the 
download to complete. All you have to do is identify the file/torrent you want to 
download from the Internet and set it in the Download function on your My Book 
World Edition. Then you can walk away and let these tools do the rest. All the files/
torrents that you want to download are saved directly to your My Book World Edition, 
and you do not even need to have your computer on.

With a user-friendly interface, the Downloader supports multiple simultaneous 
downloads with various functions to manage downloads. Use Downloader to 
download files to the default share folder in the My Book World Edition. If you choose 
not to use the default share folder, see “To set the destination share name for the 
Downloader:” on page 136.

Accessing Downloader

You can access Downloader by entering the system’s web-based user interface. See 
“Accessing My Book World Edition’s Network Storage Manager” on page 86 for 
instructions. 

1. In the Tool list, click Downloader.

2. Enter “downloader” in both the Administrator Name and Password fields. 

Note: You can change the password, but the administrator name is always “downloader.”

3. Select a language. (“English” is the default.)

4. Click Login.
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Downloader Features

Downloader includes the following features:

• Download faster with instantaneous “start”
• Download multiple files from the Internet simultaneously
• Automatically store files to a user-defined destination folder in My Book World 

Edition
• Automatically store your partially downloaded files in the database to resume 

downloading at any time
• Set download speed to reduce bandwidth consumption 
• Schedule and queue downloads
• Resume downloading a partial download

The Downloader user interface includes two tabs—HTTP/FTP  and 
CTorrent. 

HTTP/FTP Tab

 Clicking the HTTP/FTP tab reveals two buttons: Tasks and Settings. 

Tasks 

The Tasks button on the HTTP/FTP tab includes a table that displays the file 
transfer processes. The status of the file download is displayed using icons located 
on the File Name column and immediately below the Submit button. The status 
includes detailed information about the meaning of each status icon. 
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The command icons located on the right-side of the tasks table allow you to add 
download entries, stop file downloads, or delete download tasks.

Command Icons

The Tasks page includes the following commands:

To create a download task:

1. On the Tasks page, click the Add  icon.

2. Enter the full web address from which you want to download the file in the URL 
field. 

3. If a user name and password are required to download the file, click User name 
and password are required, and then enter the user name and password. 

4. If you want to enter a new name for the file, enter a new name in the Save As 
field. 

Icon Command Description

Add Creates a download task. 

Start Starts a specific download task. 

Stop Ends the download task. 

Delete Deletes download task from the table. 

Help Displays the online guide. 

Logout Exits the Downloader utility.
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5. Click Automatically to start downloading immediately after the request.

6. Click the Submit button. The task displays at the bottom of the list.

Note: The Scheduled Status field above the table on the right indicates whether the download 
was scheduled. See “Settings” on page 155 for information about scheduling tasks. 

To stop and resume a download task:

1. Select a task in the Tasks table. 

2. Click the Stop  icon to stop the download task. 

3. Click the Start  icon to resume the download task.

To delete a download task:

1. Select a task in the Tasks table. 

2. Click the Delete  icon to delete the download task.

3. Click OK, and then click OK again. 

4. Click the Submit button. 
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To change the order of the download queue:

1. Use the arrow buttons to change the order of download tasks or to make a task 
conditional on a previous task. 

2. Select a task in the Tasks table, and then click Move Up  or Move Down . 

3. Click the Submit button.

Settings 

The Settings button on the HTTP/FTP tab enables you to set the download speed 
and create and schedule several download queues. 

To customize the Downloader settings:

1. On the HTTP/FTP tab, click the Settings button to display the following page:
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2. Select a number to specify the maximum number of simultaneously running 
downloads in the Max. Running No. field. 

3. Specify the integer value to limit the downloaded speed if you do not want to 
consume the entire available bandwidth in the Download Speed field. 

4. Set up the proxy in the Proxy field to download files if your network environment 
does not allow making direct connections to an external network. 

5. Click Enable next to Schedule to enable scheduled downloading time. The 
page expands:

6. Select rows, columns, or individual days and times during which downloading is 
allowed. Selections display in yellow.

7. Click the Submit button.

Note: In the example above a schedule displays because Schedule was enabled. Specify the 
desired schedule and click the Submit button. 
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CTorrent Tab

CTorrent can be used for downloading and uploading large files among peers 
without the strain on their computers normally experienced with standard Internet 
transfers. The person downloading the file receives pieces of the file from multiple 
people who have downloaded the entire file (seeders) or have only part of the file. 

Note: If you wish to configure your router to forward CTorrent traffic to your My Book World Edition, 
the CTorrent client uses TCP ports 2106 through 2706.

The CTorrent tab displays three buttons: Tasks, Settings, and Arrangement.

Tasks 

The Tasks button on the CTorrent tab displays information about each torrent and 
enables you to control torrent downloads.

To view a task:

1. Click the Tasks button on the CTorrent tab to display the following page:
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The Tasks page displays the following information about each torrent:

• Torrent name 
• File size 
• Progress of download 
• Download speed (KB per second)
• Upload speed (KB per second)
• Up/Down Ratio (A percentage that represents the amount of data uploaded 

divided by the amount of data downloaded.)
• Time Left
• Health

The following icons describe the status and details for each torrent.

Status: (connecting to tracker to start), (Incomplete & Downloading/Uploading 

(peer)), (Stopped & Complete), (Hash-Checking data), (Unable to Write to 

Disk/Unable to Hash-Check data),  (Connecting to Peers),  (Complete and 
Uploading peers),  (Stopped & Incomplete) and  (Queued).

Details: The  icon provides detailed information about the selected torrent. Click  

to display three tabs with a summary of the torrent details, a list of files in the 
torrent, and the peers used to download/upload the torrent. 

To view a detailed summary:

1. On the Tasks page, click the  icon at the end of the torrent’s row.

2. Click the Summary tab to view a summary of details: 

It includes the following information about the torrent:

• File name

• Save location

• Total file size

• Progress of the download

• How much still needs to be downloaded
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• Progress of the download as a percentage

• Download rate (KB/s)

• Upload rate (KB/s)

• The amount of data downloaded so far

• The amount of data uploaded so far

To view information about the individual files in the torrent:

1. On the Tasks page, click the  icon at the end of the torrent’s row.

2. Click the Files tab to view information about the individual files in the torrent. The 
details include the percentage of the specified file downloaded and the size of 
each file.

To view information about the peers sharing torrent files with you:

1. On the Tasks page, click the  icon at the end of the torrent’s row.

2. Click the Peers tab to view information about the peers who are sharing torrent 
files with you and the percentage of the torrent they possess.
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To create a task:

Before adding a torrent, first locate it on the Internet and save the *.torrent file to your 
computer.

1. On the Tasks tab, click the  icon. The following page displays:

2. Browse your computer to locate the torrent file you saved from a torrent tracker 
on the Internet.

3. Click the Submit button The task displays at the bottom of the task list.

To delete a task:

You can delete a download task, but the system does not delete it from the My Book 
World Edition data volume where it is stored.

1. Select the task on the Tasks tab. 

2. Click the  icon.

To start and stop a task:

When you first add a task, you must start the download. You can stop and resume the 
download at any time.

1. To start a download, select it and click the  icon.

2. To stop a download, select it and click the   icon.
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Settings 

The Settings button on the CTorrent tab enables you to customize the amount of 
bandwidth used by a torrent download.

To customize CTorrent settings:

1. Click the Settings button on the CTorrent tab to display the following:

2. To set the speed of the download or upload, in the General Settings group:
(a) In Max DL Rate, enter the maximum rate at which the CTorrent should be downloaded 

(KB/sec). 

(b) In Max UL Rate, enter the maximum rate at which the CTorrent should be uploaded 
(KB/sec).

3. To automatically stop the download under specified conditions, in the Auto Stop 
CT Torrent Task group:
(a) To enable automatic stopping of the download under specified conditions, click the Enable 

check box.

(b) In Stop Criterion, select whether the download should automatically stop when one of the 
conditions is met or only when all conditions are met. 

(c) In Share Ratio, enter the ratio (percentage) of the download completed to the upload 
completed that will trigger an automatic stop. 

(d) In Seed Ratio, enter the number of peers who have downloaded the entire file that will 
trigger an automatic stop.

(e) In Seeding Time, enter how much longer after you have the entire file the download should 
stop.

4. Click the Submit button. 
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Arrangement  

The Arrangement button on the CTorrent tab enables you to prioritize your 
downloads. The position of a torrent in the list determines its priority.

1. Click the Arrangement button on the CTorrent tab to display the following: 

2. To change priority for a torrent, click the radio button next to it.

3. Click Move Up or Move Down to change its position in the list.

4. Repeat for any other torrents, as desired. 

5. Click the Submit button to apply the changes.
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Connecting and Managing a USB Hard Drive

Connecting

Connect a USB hard drive to the USB port on the rear of your My Book World 
Edition for additional storage. The USB drive appears as a Folder Share in Network 
Storage Manager. See “Folder Shares” on page 95 (Basic Mode) or “Folder Shares” 
on page 129 (Advanced Mode) for details.

Note: The My Book World Edition supports external USB storage; USB optical drives (CD/DVD 
combo or a DVD dual/multi drive) are not supported. The USB port currently supports attached 
drives with FAT32, NTFS, EXT3, and HFS+J file systems. Proprietary devices (e.g., cameras) are not 
currently supported

Important: USB hard drives that are formatted with FAT32 are limited to 
only 4 GB that can be copied for each file. If you try to transfer files that are 
larger, you will receive a Copy Termination error.

Copy Manager

The My Book World Edition’s Copy Manager feature allows you to back up data from 
the USB hard drive to My Book World Edition or back up data from the My Book 
World Edition to the USB hard drive. See “Click the Submit button to apply the 
changes.” on page 162 for instructions.

The My Book World Edition’s Copy Manager feature allows you to copy data from a 
USB drive to the My Book World Edition or copy data from the My Book World 
Edition to a USB drive. 
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Important: For best results, when copying data, always connect the USB 
drive directly to a USB port on the My Book World Edition. Do not use a 
USB hub. Ensure that the destination drive has enough free space to store 
the amount of data being transferred.

Important: USB drives that are formatted with FAT32 are limited to 
copying only 4 GB for each file. If you try to transfer files that are larger than 
4 GB, you may encounter a Copy Termination error.

Accessing Copy Manager

You can access Copy Manager by entering the system’s web-based user interface. 
See “Accessing My Book World Edition’s Network Storage Manager” on page 86 for 
instructions. 

1. In the Tools list, click Copy Manager.

2. Enter the administrator name and password. The defaults are “admin” and 
“admin.”

3. Select a language. (“English” is the default.)

4. Click Login.
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My Book World Edition-to-USB Copy

The default operation for the Copy Manager is NAS to USB Copy. 

1. Select NAS as the Source.

2. Browse to the source folder in the Source Folder Selection list or enter the 
path manually. Click the Next button.

3. Select USB as the Destination.

4. Browse to the destination folder in the Destination Folder Selection list or 
enter the path manually. You can also create a new folder by entering “/folder 
name” after browsing to the end. 

Note: You can only create new folders one level at a time.

5. Click the Next button.
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6. Click the Start button. 

7. Click OK. Any file on the destination drive with the same name as a file on the 
source drive is be overwritten. 

USB-to-My Book World Edition Copy
1. Select USB as the source.

2. Browse to the source folder in the Source Folder Selection list or enter the 
path manually. Click the Next button.

3. Select NAS as the destination.
CONNECTING AND MANAGING A USB HARD DRIVE - 166



MY BOOK WORLD EDITION
USER MANUAL
4. Browse to the destination folder in the Destination Folder Selection list or 
enter the path manually. Click the Next button.

5. Click the Start button.         

6. Click OK. Any file on the destination drive with the same name as a file on the 
source drive is overwritten. 
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7. The copy operation begins. Click the Stop button if you wish to stop the copy.

8. Click OK.

Copy Logs

The Logs tab provides a record of all copy activities for the session.

1. To view a log of copy activities, click the Logs tab to display:
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Replacing a Drive (My Book World Edition II)

My Book World Edition II is a limited user-serviceable product which allows for 
servicing one or both internal hard drives in the enclosure. 

Important: Only WD Caviar® Green™ hard drive assemblies can be 
inserted into the My Book World Edition enclosure. Visit support.wdc.com 
and search the knowledge base article 2569 for detailed instructions on 
obtaining a replacement drive for this product. Use only WD hard drive 
assemblies or your warranty will be voided.

If the LEDs on the unit are flashing, a network drive may be faulty. To determine which 
drive is faulty, do the following:

1. Open WD Discovery and select the unit.

2. Click Configure and log in.

3. Click the Advanced view and then click the Storage tab.

4. Click the Disk Manager icon. 

The “Unassigned” drive is the defective one. The number corresponds to the A or 
B color coded decal on the drive, as shown on the next page.

In the event a fault occurs and you would like to service the device yourself, visit WD 
Technical Support at support.wdc.com and search the knowledge base article 1709 
for detailed instructions on obtaining a replacement drive. When contacting 
Technical Support, have the following items ready: My Book serial number, date of 
purchase, and the serial number of the internal hard drive(s) which require 
replacement. Once you have received the replacement drive(s), follow the steps 
below to service the dual-drive storage system.

Important: To avoid electrostatic discharge (ESD) problems, ground 
yourself by touching the metal chassis of the computer before handling the 
device.
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Before getting started, power off the unit and disconnect all of its cables. 

1. Place the unit on a clean and stable surface.

2. Using your thumb, firmly push down on the top front panel of the unit to release 
the latch and open the cover.

3. Loosen the thumbscrew that secures the drive cover plate. Remove the drive 
cover plate and set aside.

Note: Each drive is designated A or B by a color coded decal. 

1

2

3
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4. Locate the drive you wish to replace (A or B). Using the pull tab, carefully and 
slowly pull the drive assembly up and out of the enclosure and set aside. 

5. Gently slide the replacement drive assembly into the drive slot until is fully 
inserted.

6. Replace the cover plate by sliding it under and between the pull tabs and 
securing it with the thumbscrew.

Note: Do not overtighten the thumbscrew.
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7. Close the cover and firmly push down until it locks into place.

8. Reconnect only the power cable to the device. Do not connect computer 
interface cables. 

9. The drive starts the rebuild process automatically and the LEDs cycle from 
bottom to top. The RAID rebuild may take up to 12 hours depending on drive 
capacity and activity, but typically completes in 5-7 hours. Allow the RAID rebuild 
to complete.

Important: Do not attempt to use the device during the rebuild process.

10.Once complete, the LEDs glow steadily to indicate power-on state.

11.Connect the interface cable.

12.Return the faulty drive following the instructions provided in the WD knowledge 
base article# 1709.

Important: Do not disassemble the internal drive and attached assembly 
components. Return the entire internal drive assembly intact to WD.
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Troubleshooting
For any issue, first ensure that you are using the latest firmware for My Book World 
Edition. The latest firmware includes the latest network and SATA disk drivers. See 
“Update (Firmware)” on page 107 for instructions.

First steps checklist
• AC power available at the wall outlet?
• Is the power supply plugged in?
• Check the DC cable(s) on the back of the chassis and the AC source.
• Check the cable from the wall to the power supply and the cable from the power 

supply to the chassis.
• Are all cables correctly connected and secured?
• Are all peripheral devices installed correctly?
• Are all device drivers properly installed?
• Did you press the power button on the front panel to turn the device on (power 

indicator should be lit)?
• Is the power cord properly connected to the device and plugged into an outlet for 

100-127 V or 200-240 V?

Resetting the My Book World Edition 

To reset the system using the reset button:
If you have forgotten your password, or if the network is misconfigured, pressing the 
reset button while the device is powered up resets the admin user name, admin 
password, and IP settings to the default values without erasing shared folders or 
volumes. Follow the instructions below to reset the device using the recovery button.

WARNING: Do not move the unit while it is turned on.

1. Carefully turn the device around so that you have access to the back of the unit.

2. With the device powered on, insert a paperclip or narrow tipped pen into the 
reset button slot on the back of the unit. 

3. Press and hold down the reset button for four seconds. The device reboots (this 
may take up to three minutes).

Note: The default user name and password is admin.
14
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To reset the system to factory default settings:

Performing a factory default reset using the Network Storage Manager erases all 
settings, shares, and data files in the My Book World Edition. All information and data 
is lost. For detailed instructions, see “To restore the device to factory defaults:” on 
page 112.

Hardware Diagnostic Testing

This section provides a detailed approach to identifying a hardware problem and 
locating its source.

WARNING! Before disconnecting any peripheral cables from the system, 
turn off the My Book World Edition and any external peripheral devices. 
Failure to do so can cause permanent damage to the My Book World 
Edition and/or the peripheral devices.

1. Turn off the My Book World Edition and all external peripheral devices. 

2. Make sure the power cord is plugged into a properly grounded AC outlet.

3. Turn on the device. If the power indicator on the front panel does not light, see 
“LEDs do not light up.” on page 174.

Specific Problems and Corrective Actions

The following contains specific problems that may arise during the use of the My 
Book World Edition. Possible solutions are listed for each problem. 

LEDs do not light up.

Do the following:

• Make sure the power button on the rear of the device is turned on. 
• Make sure the power cord is connected correctly. 
• Make sure that the wall outlet has power. Test it by plugging in another device. 

System cannot connect to a network and network status indicator does not light.

• Make sure the network cable is securely attached to the correct connector on the 
rear panel of the device.

• Try a different network cable.
• Make sure the network switch or router has power.
• Check the cabling and network equipment to make sure that all cables are 

properly connected.
• Try another port on the switch.

Network Storage Manager does not appear when I click Configure in WD Discovery.

Make sure JavaScript is enabled in your browser. See your browser’s Help menu for 
instructions.
TROUBLESHOOTING - 174



MY BOOK WORLD EDITION
USER MANUAL
I received a banner warning message, e-mail alert, or pop-up screen indicating a failed volume.

Do the following:

1. Verify hard drive status in the Disk Manager icon. See “Disk Manager” on page 
123. If the status of any drive is “Failed,” visit WD Technical Support at 
support.wdc.com and search the knowledge base article 2569 for detailed 
instructions on obtaining a replacement drive.

2. If Disk Manager does not indicate that a hard drive has failed, power the device 
off and on.

3. If the volume that failed is a new volume, try rebuilding the RAID array. See 
“Manage RAID (My Book World Edition II)” on page 126 for details. If this does 
not resolve the problem, visit WD Technical Support at support.wdc.com and 
search for the knowledge base article 2569 for detailed instructions on obtaining 
a replacement drive.

My router has failed or is not available. How do I access my data in the device?

Do the following:

1. Connect the device directly to the computer's Ethernet port. 

2. Launch WD Discovery Tool and see “Mapping a Network Drive” on page 75 for 
instructions on how to access data in the device.

I received the message “iTunes server cannot find the path to Shared Music.” 

The iTunes server service requires the presence of the /Public/Shared Music share 
folder. Do not rename or delete Shared Music if you want to use the iTunes server. 
You must recreate or rename the ‘/Public/Shared Music’ share if it has been deleted 
or renamed.

I cannot start WD Discovery to access the configure feature.

Do the following:

1. Click Start>Run.

2. Type \\mybookworld, and then click OK (if the device name was changed, type 
\\yournewdevicename).

3. The My Book World Edition directory displays (Public, Configuration, and 
Download folders). Double-click the Configuration folder.

4. Double-click index.html. The configuration login screen displays.
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My router has failed. How do you map the drive letter without WD Discovery Tool?

Do the following:

1. Connect the device directly to the computer's Ethernet port.

2. Double-click My Computer.

3. Click My Network Places.

4. On the Tools menu, point to Map Network Drive.

5. Leave the default drive set to Z.

6. In the Folder drop-down list, select \\device name\public.

7. Click the Finish button.

8. Go back to the opening window of My Computer to view the public folder of 
your device under Network Drives.

I want to install Windows drivers on my Windows Vista/Windows 7 computer without access to 
Windows update:

1. Insert the My Book World Edition CD and right-click the My Book World Edition 
icon in My Computer. 

2. For the two-drive model, click Open>WD_Windows>Tools> 
WD_Rally_Drivers> PnPxNas-2NC. Right-click PnPxNas-2NC.inf and click 
Install. 

3. For the one-drive model, click Open>WD_Windows>Tools> 
WD_Rally_Drivers> PnPxNas-1NC. Right-click PnPxNas-1NC.inf and click 
Install.

I am unable to play music, videos and/or view pictures through my digital media adapter.

The media adapter requires the presence of the /Public/Shared Music /Public/
Shared Pictures and /Public/Shared Videos share folder. Do not rename or delete 
the shared folders if you want to use the media adapter. You must recreate or rename 
the share if it has been deleted or named something else.

Because there are many kinds of file formats for pictures, videos and music, your 
particular digital media adapter may not support a format to play or display it. 
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Depending on the digital media adapter device (for example, Xbox 360 or 
PlayStation 3) that you have, you may need to update your device with the proper 
CODECs to support the media format that you want to play. Please refer to your 
digital media adapter’s user manual for further information of how to locate and 
update CODECs.

System Events

The following table describes the event types that are recorded in the system log. 

Event type and ID State Value Critical Warning

System events

Startup [none]

Abnormal Shutdown [none]

Shutdown [none]

Reboot [none]

Software Update Succeeded Version

Software Update Failed

Factory Default Succeeded

Thermal events

Thermal 1 Normal Degrees

Thermal 1 Exceeded the threshold (Overheated) Degrees

HDD SMART events

HDD [1,2] HDD SMART OK

HDD [1,2] HDD SMART fail

Volume events

Volume Sent if volume could not be recovered

Volume Volume doesn't exist

Volume Volume created

Volume Volume deleted

Volume Volume modified

Volume events (My Book World Edition II)

Volume RAID volume in normal mode

Volume (Span) Volume Extend Failed

Volume Volume Resync Failed

Volume (RAID 1) RAID volume in degraded mode

Volume (RAID 1) RAID volume resyncing Progress

Volume usage events

Volume [1,2] Volume has 25~100% free capacity
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Volume [1,2] Volume has more than 10% free 
capacity

Volume [1,2] Volume has more than 5% free capacity

Volume [1,2] Volume has reached 80% capacity

Volume [1,2] Volume has reached 95% capacity

Volume [1,2] Volume has reached full capacity

Volume [1,2] Volume had NOT been mounted

Network events

LAN 1 Link Ok Speed 
(Mbps: 
1000/100/
10)

LAN 1 Link down

LAN 1 Use dynamic IP address got from 
DHCP

IP address

LAN 1 Can not get IP address from DHCP, use 
default

IP address

LAN 1 Cannot get IP address from DHCP 
server, use zeroconf.

IP address

USB events

USB [1] Copy Manager did not finish because 
external drive is full

USB [1] USB disk insertion

USB [1] USB disk safely removed

USB [1] USB disk unsafely removed

USB [1] USB disk format OK

USB [1] USB disk format fail

User events

[User ID] User quota is normal

[User ID] User quota reached 90%

[User ID] User quota is full

[User ID] User created

[User ID] User deleted

[User ID] User modified

Group events

[Group ID] Group created

[Group ID] Group deleted

[Group ID] Group modified

Event type and ID State Value Critical Warning
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Other events

Volume [1,2] Volume extend failed

Volume [1,2] Volume resync failed

Event type and ID State Value Critical Warning
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Glossary
AFP — Apple Filing Protocol. The network protocol for sharing files and file services 
in an AppleTalk network.

CTorrent — A computer program for downloading and uploading large files among 
peers without the strain on their computers normally experienced with standard 
Internet transfers. The person downloading the file receives pieces of the file from 
multiple people who have downloaded the entire file (seeders) or have only part of 
the file.

CIFS — Common Internet File System. The recommended file sharing protocol for 
Windows platform allows users to access shares through My Network Places. Mac 
OS X or later also supports the CIFS protocol. See also Protocol.

DHCP — Dynamic Host Configuration Protocol. A protocol for assigning IP 
addresses to devices on a network. With dynamic addressing, a device can have a 
different IP address each time it connects to the network. In some systems, the 
device's IP address even changes while it is still connected. DHCP also supports a 
mix of static and dynamic IP addresses. See also Protocol.

DLNA — Digital Living Network Alliance. The group of consumer electronics, 
computing industry, and mobile device companies that sets standards for product 
compatibility, thus enabling users to share content in their home.

DMA — Digital Media Adapter. A device that gives home entertainment devices the 
ability to transfer media such as music, photos, videos to and from other devices over 
the network.

DNS — Domain Name Service. A system that allows a network name server to 
translate text host names into numeric IP addresses used to uniquely identify any 
device connected to the Internet.

ESD — Electrostatic discharge.

Ethernet — A standard method of connecting computers to a Local Area Network 
(LAN) using coaxial cable.

Extended Partition — A partition on a disk where non-system files (other than DOS 
or operating system files) can be stored. Multiple partitions can be created on a hard 
disk: one primary partition and one or more extended partition(s). Operating system 
files must reside on the primary partition; logical drives can be created on an 
extended partition.

FAT — File Allocation Table. A data table stored at the beginning of each partition on 
a disk and used by the operating system to determine which sectors are allocated to 
each file and in which sequence.

FAT32 — A file allocation table system with a maximum file transfer of 4 GB and a 
maximum partition size of 32 GB.
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File Transfer Protocol (FTP) — A network protocol used to transfer data from one 
computer to another through a network. FTP is a popular choice for exchanging files 
independent of the operating systems involved.

GreenPower™ Technology — Engineering technology developed by WD to bring 
more energy-efficient hard drive options to our customers. WD hard drives with 
GreenPower technology yield average power savings of 4-5 watts over competitors' 
drives while maintaining solid performance. 

Host — The computer to which other computers and peripherals connect. 

Host Adapter — A plug-in board that acts as an interface between a computer 
system bus and a hard drive.

Host Interface — The point at which a host and a drive are connected to each 
other.

Host Transfer Rate — The speed at which a host computer can transfer data 
across an interface.

HTTP — Hypertext Transfer Protocol. Protocol used by the World Wide Web to 
transfer information between servers and browsers. See also Protocol.

HTTPS — Hypertext Transfer Protocol over Secure Socket Layer. A protocol that 
provides a more secure means of configuring your device than HTTP, but may affect 
the responsiveness of the user interface. All traffic between the managing computer 
and the My Book World Edition is encrypted. See also Protocol.

Hub — In a network, a device joining communication lines at a central location, 
providing a common connection to all devices on the network.

Identity LED — Indicates which My Book World Edition in the network is currently 
being accessed via WD Discovery. 

Interface — A hardware or software protocol to manage the exchange of data 
between a device and a computer; the most common ones are EIDE (also known as 
PATA), SATA, and SCSI. See also Protocol.

JBOD — Just a Bunch Of Disks. A collection of hard disks provided as separate 
volumes. They are not configured according to RAID, so they have no redundancy 
capabilities to enable recovery if data becomes corrupted.

IP — Internet Protocol. A system that controls how data messages are separated into 
packets, routed from the sender, and reassembled at the destination. See also 
Protocol.

IP address — A 32-bit, binary number that uniquely identifies a computer connected 
to the Internet.

LAN — Local Area Network. A system in which computer users in the same company 
or organization are linked to each other and often to centrally-stored collections of 
data in LAN servers.
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LED — Light-emitting Diode. An electronic device that lights up when electricity is 
passed through it.

Media Server — Device that stores and shares media files (digital audio, digital 
video, and digital photos).

Media Storage — Device that stores media files (digital audio, digital video, and 
digital photos).

Memory — A device or system capable of storing and retrieving data.

MioNet® — WD remote computer access service. Adding MioNet to your home or 
work computer allows you secure and instant access from any PC in the world back 
to your computer. You can use your applications and access and share files on your 
computer or storage device from anywhere. 

Mirroring — The process of generating an exact copy of saved data from one drive 
to another drive within a RAID 1 system. Each drive can be accessed and read 
separately. A mirrored drive can be removed from a system while the other drive(s) 
are still active. See also RAID 1.

MP3 — MPEG-audio layer 3. A digital audio coding scheme for distributing music 
over the Internet.

Multi-user — A system in information technology that enables more than one user to 
access data at the same time.

NAS — Network Attached Storage. Hard disk storage that is set up with its own 
network address rather than being attached to the computer that is serving network 
workstation users.

NAT  — Network Address Translation. Used in gateway devices that form the 
boundary between the public Internet and the private LAN. As IP packets from the 
private LAN traverse the gateway, NAT translates a private IP address and port 
number to a public IP address and port number, tracking those translations to keep 
individual sessions intact. 

Network Computer — A computer that communicates with a central data storage 
facility such as a server or RAID system.

NFS — Network File System. A network file system protocol that allows a user on a 
client computer to access files over a network as easily as if the network devices 
were attached to its local disks. Normally associated with UNIX systems. See also 
Protocol.

NTFS — NT File System. A file system, designed for Windows® NT, that supports 
long filenames, security access control, recovery, and other features.

NTP — Network Time Protocol. A protocol for synchronizing the clocks of computers 
and equipment over a network. See also Protocol.

Operating System — Software that allows users and programs installed on your 
system to communicate with computer hardware such as a hard drive.
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Partition — A logical division on a hard drive that the operating system treats as a 
separate hard drive. Each partition is assigned a unique drive letter.

Port (Hardware) — A specialized outlet on a device for connecting to other devices 
using a cable or a plug. Ethernet ports, power ports, and USB ports are examples.

Protocol — A convention of data transmission that defines timing, control format, 
and data representation.

RAID — Redundant Array of Independent Disks. A grouping of hard drives in a single 
system to provide greater performance and data integrity.

RAID 0 — RAID protocol in which data is striped across multiple hard drives, 
enabling the accelerated reading and recording of data by combining the work of two 
or more drives to increase performance. See also Striping.

RAID 1 — RAID protocol in which two copies of the data are instantaneously 
recorded — each on separate hard drives. RAID 1 ensures the protection of users' 
data because in the event that one of the hard drives fails, the other hard drive(s) 
continue to read and write data until the faulty hard drive is replaced and rebuilt to 
once again safely mirror the data. See also Mirroring.

RAM — Random Access Memory. Memory that allows any storage location to be 
accessed randomly, as opposed to sequential access devices such as tape drives.

ROM — Read-Only Memory. An integrated circuit memory chip containing programs 
and data that the computer or host can read but cannot modify. A computer can read 
instructions from ROM but cannot store data in ROM.

Share — A folder that can be used to organize and store files on your My Book 
World Edition. Shares can be shared with everyone (public) or with selected users on 
your network (private).

SMB — Server Message Block. File-sharing protocol for Windows platform that 
allows users to access shares through My Network Places. Mac OS X or later also 
supports the CIFS protocol. See also Protocol.

SMTP — Simple Mail Transfer Protocol. Standard for transferring e-mail across the 
Internet. See also Protocol.

Spanned — Combines drives in a linear fashion to create one large logical volume. A 
spanned drive is like a single, bigger drive, in that files written to the volume earlier go 
to the “beginning” of the volume, on the first physical drive. If one of the drives fails, all 
data is lost. 

SSH — Secure Shell. A network protocol that uses encryption and authentication 
keys to enable two devices on the network to exchange data securely. See also 
Protocol.

SSL — Secure Socket Layer. A protocol that provides authentication and encryption 
services between a web server and a web browser. See also Protocol.

Streaming Media — Media such as audio, video, and photos that are constantly 
received while being delivered by a streaming provider.
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Striping — The spread of data over multiple hard drives to improve performance. 
See also RAID 0.

TCP/IP — Transmission Control Protocol/Internet Protocol. A set of protocols for 
communication over interconnected networks. The standard for data transmission 
over networks. See also Protocol.

Twonky Media Server — A server application that searches for all the media (for 
example, videos, photos, and music) stored on the My Book World Edition connected 
to your home network. 

UPnP — Universal Plug n Play. A set of computer network protocols that simplify the 
implementation of networks in the home by allowing devices to connect seamlessly. 
See also Protocol.

UPnP NAT Traversal — Combines UPnP and NAT features. 

USB — Universal Serial Bus. A serial bus for connecting peripherals to a 
microcomputer. It connects external drives, printers, modems, mice, keyboards, etc., 
through a single, general-purpose port. It can automatically add and configure new 
devices without having to shut down and restart the system.

USB 2.0 — For most PCs, the standard interface is USB. Hi-Speed USB (USB 2.0) 
supports data transfer rates up to 480Mb/s. USB 2.0 is backward-compatible with 
USB 1.1. — If you connect to a USB 1.1 device, data is transferred at USB 1.1 
speed (up to 
1.1 Mb/s).

WAN — Wide Area Network. A computer network that crosses metropolitan, 
regional, or national boundaries.

WD Anywhere Backup — WD backup software that allows the user to set up 
continuous backup of all or selected files for up to five computers in a network. This 
feature backs up your data to the My Book World Edition so you can restore your 
data in the event that a computer’s hard drive crashes. 

WD Discovery™ — WD software application that allows the host computer to find 
one or more WD My Book World Editions in the same network segment.
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Appendix

Regulatory Compliance

FCC Class B Information

This device has been tested and found to comply with the limits of a Class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This 
unit generates, uses, and can radiate radio frequency energy and, if not installed and 
used in accordance with the instructions, may cause harmful interference to radio or 
television reception. However, there is no guarantee that interference will not occur in 
a particular installation. Any changes or modifications not expressly approved by WD 
could void the user's authority to operate this equipment.

The following booklet, prepared by the Federal Communications Commission, may 
be helpful: How to Identify and Resolve Radio/TV Interference Problems. This 
booklet is Stock No. 004-000-00345-4 available from the US Government Printing 
Office, Washington, DC 20402.

The provided Ethernet cable must be used between the unit and network connection 
to comply with FCC Part 15 Class B and EN-55022 Class B.

ICES/NMB-003 Compliance

Cet appareil de la classe B est conforme à la norme NMB-003 du Canada.

This device complies with Canadian ICES-003 Class B.

Safety Compliance

Approved for US and Canada. CAN/CSA-C22.2 No. 60950-1, UL 60950-1: Safety 
of Information Technology Equipment.

Approuvé pour les Etats-Unis et le Canada. CAN/CSA-C22.2 No. 60950-1 : Sûreté 
d'équipement de technologie de l'information.

This product is intended to be supplied by a listed limited power source, double 
insulated, or direct plug-in power unit marked “Class 2.”

CE Compliance for Europe

Verified to comply with EN55022 for RF emission;  EN-55024 for Generic Immunity, 
as applicable; and EN-60950 for Safety.
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Environmental Compliance (China)

Warranty Information

Obtaining Service
WD values your business and always attempts to provide you the very best of 
service. If this Product requires maintenance, either contact the dealer from whom 
you originally purchased the Product or visit our product support website at 
support.wdc.com for information on how to obtain service or a Return Material 
Authorization (RMA). If it is determined that the Product may be defective, you will be 
given an RMA number and instructions for Product return. An unauthorized return 
(i.e., one for which an RMA number has not been issued) will be returned to you at 
your expense. Authorized returns must be shipped in an approved shipping container, 
prepaid and insured, to the address provided on your return paperwork. Your original 
box and packaging materials should be kept for storing or shipping your WD product. 
To conclusively establish the period of warranty, check the warranty expiration (serial 
number required) via support.wdc.com. WD shall have no liability for lost data 
regardless of the cause, recovery of lost data, or data contained in any Product 
placed in its possession.

Limited Warranty
WD warrants that the Product, in the course of its normal use, will be free from 
defects in material and workmanship for a period of three (3) years, unless otherwise 
required by law, and will conform to WD’s specification therefor. This limited warranty 
period shall commence on the purchase date appearing on your purchase receipt. 
WD shall have no liability for any Product returned if WD determines that the Product 
was stolen from WD or that the asserted defect a) is not present, b) cannot 
reasonably be rectified because of damage occurring before WD receives the 
Product, or c) is attributable to misuse, improper installation, alteration (including 
removing or obliterating labels and opening or removing external enclosures, 
including the mounting frame, unless the product is on the list of limited user-
serviceable products and the specific alteration is within the scope of the applicable 
instructions, as found at support.wdc.com), accident or mishandling while in the 
possession of someone other than WD. Subject to the limitations specified above, 
your sole and exclusive warranty shall be, during the period of warranty specified 
above and at WD’s option, the repair or replacement of the Product. The foregoing 
warranty of WD shall extend to repaired or replaced Products for the balance of the 
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applicable period of the original warranty or ninety (90) days from the date of 
shipment of a repaired or replaced Product, whichever is longer.
The foregoing limited warranty is WD’s sole warranty and is applicable only to 
products sold as new. The remedies provided herein are in lieu of a) any and all other 
remedies and warranties, whether expressed, implied or statutory, including but not 
limited to, any implied warranty of merchantability or fitness for a particular purpose, 
and b) any and all obligations and liabilities of WD for damages including, but not 
limited to accidental, consequential, or special damages, or any financial loss, lost 
profits or expenses, or lost data arising out of or in connection with the purchase, 
use, or performance of the Product, even if WD has been advised of the possibility of 
such damages. In the United States, some states do not allow exclusion or limitations 
of incidental or consequential damages, so the limitations above may not apply to 
you. This warranty gives you specific legal rights, and you may also have other rights 
which vary from state to state.

GNU General Public License (“GPL”)
Firmware incorporated into My Book World Edition includes third party copyrighted 
software licensed under the GPL (“GPL Software”). In accordance with the GPL: 1) 
the source code for the GPL Software may be obtained at support.wdc.com/
download/gpl; 2) you may re-use, re-distribute and modify the GPL Software; 3) with 
respect solely to the GPL Software, it is provided “as is” without warranty of any kind, 
either expressed or implied, including, but not limited to, the implied warranties of 
merchantability and fitness for a particular purpose, to the extent permitted by 
applicable law; and 4) a copy of the GPL is included on the enclosed CD, may be 
obtained at www.gnu.org, and may also be found at support.wdc.com/download/gpl.
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Index

A
accessories 5
admin login password 106
Advanced Mode 101
audio streaming in iTunes 73, 139

B
backup

automatic and complete 27
customized 29
logs 43
NAS to USB hard drive 165
restore 38
USB to NAS 166

backup plan
create 29
edit 42
icons 42
remove 43

Basic Mode 90
browse network shares 77

C
capacity gauge 10
CE compliance 185
change password

Downloader 136
login 106

China RoHS 186
compliance, regulatory 185
Copy Manager 162, 163
C-Torrent client 157

D
datavolume user quota 135
date 91
delete a backup plan 43
device name 90
digital media adapters 72
disk manager 123
DLNA media devices 72
domains 120
download queue, change order of 155
download task, create 153
Downloader 151

access 151
change password 136
command icons 153
configure settings 155
destination share setup 136
features 152
HTTP/FTP 152
torrents 157

downloads menu 136
drive

format 3
replacement 169

E
e-mail notifications setup 104
environmental compliance (China) 186
ESD precautions 169
Europe, CE compliance 185
extendvolume user quota 135

F
FCC Class B information 185
file sharing 58
file sharing protocols 131
folder share permissions 143
folder shares 129
FTP

access data 119
logs 150

G
general setup 102
GNU general public license 187
GPL software 187
group account

assign access rights 144
create 142
modify 143

H
hardware setup 11
HDD standby 114
HTTP/FTP downloads 152

I
ICES/NMB-003 compliance 185
icons, C-Torrent 158
indicators 10
iTunes server

enable 139
streaming audio 73, 139
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K
kit contents 5

L
LAN submenu 116
laptop user practices 23
LED

capacity gauge 10
control 114
indicators 10

lights 10
limited warranty 186
log settings, configure 150
login password 106
logs

CIFS 149
system 148

M
Mac OS X

access Network Storage Manager 87
install WD Anywhere Backup 25
Leopard/Snow Leopard, access My

Book World Edition 19
Tiger, access My Book World

Edition 20
manage RAID 124
manage RAID options 128
manage volume 125
mapping a drive manually 77
media

devices 66, 72
digital adapters 72
iTunes 138
storage 64

media player, WD TV Live HD 68
media server, iTunes 73
Media tab 138
media types supported 64
MioNet

access files 57, 58
remote access 54
share files 58
share photos 58
transfer files 61
Web 57

My Book World Edition configuration 81

N
network

drive mapping 75
LAN 116
mode 92
services 117, 118
settings configuration 116
shares 77
workgroup setup 119

Network Storage Manager
access using Mac 87
access using Windows 86
Advanced Mode 100, 101

Media 138
Network 115
Status 147
Storage 122
System 102
Users 140

Basic Mode 90
Date & Time 91
Device Name 90
Folder Shares 95
Network 92
Remote Access 97
Shutdown/Reboot 100
System Status 97
Users 93

basics 81
features 87
toolbar 89
UI overview 88
use 81

O
obtaining service 186
one-click backup 26

P
permissions

folder share 143
USB share 145

PlayStation 3 71
pop-up message alert setup 105
ports 8
power button 9
pre-installation requirements 6
product registration 2

Q
quota

configuration 134
user 135

R
RAID

levels 126
INDEX – 189



MY BOOK WORLD EDITION
USER MANUAL
options 128
RAID 0 (Striped) 3
RAID 1 (mirrored) 3
Rally 15
reboot 100
recovery button 173
registration, product 2
regulatory compliance 185
remote access 57
replacing a drive 169
reset button 8
restore

configuration 110
factory defaults 112

RoHS 186
RSA key 113

S
safety compliance 185
safety instructions 2
scheduled downloads 151
security slot 9
service, WD 186
shares 129

access data 77
browse 77
create 96, 130
delete 97
folder 129

sharing files 58
shortcut creation 79
shutdown/reboot 100
software, GPL 187
specifications 4
SSH 112
SSL certificate and key pairs 113
status

FTP logs 150
log settings 150
system 147

Status tab 147
storage

destination shares 136
disk manager 123
downloads 136
folder shares 129
quota 133, 135
user quota 135
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